
IDL Version 6.2
July 2005 Edition
Copyright © RSI
All Rights Reserved

Getting Started
with IDL

0705IDL62GS

getstart.book  Page 1  Tuesday, June 14, 2005  12:07 PM



Restricted Rights Notice
The IDL®, ION Script™, and ION Java™ software programs and the accompanying procedures, 
functions, and documentation described herein are sold under license agreement. Their use, dupli-
cation, and disclosure are subject to the restrictions stated in the license agreement. RSI reserves 
the right to make changes to this document at any time and without notice.

Limitation of Warranty
RSI makes no warranties, either express or implied, as to any matter not expressly set forth in the 
license agreement, including without limitation the condition of the software, merchantability, or 
fitness for any particular purpose.

RSI shall not be liable for any direct, consequential, or other damages suffered by the Licensee or 
any others resulting from use of the IDL or ION software packages or their documentation.

Permission to Reproduce this Manual
If you are a licensed user of this product, RSI grants you a limited, nontransferable license to repro-
duce this particular document provided such copies are for your use only and are not sold or dis-
tributed to third parties. All such copies must contain the title page and this notice page in their 
entirety.

Acknowledgments
IDL® is a registered trademark and ION™, ION Script™, ION Java™, are trademarks of ITT Industries, registered in the United 
States Patent and Trademark Office, for the computer program described herein.

Numerical Recipes™ is a trademark of Numerical Recipes Software. Numerical Recipes routines are used by permission.

GRG2™ is a trademark of Windward Technologies, Inc. The GRG2 software for nonlinear optimization is used by permission.

NCSA Hierarchical Data Format (HDF) Software Library and Utilities
Copyright 1988-2001 The Board of Trustees of the University of Illinois
All rights reserved.

NCSA HDF5 (Hierarchical Data Format 5) Software Library and Utilities 
Copyright 1998-2002 by the Board of Trustees of the University of Illinois. All rights reserved.

CDF Library
Copyright © 2002 National Space Science Data Center
NASA/Goddard Space Flight Center

NetCDF Library
Copyright © 1993-1999 University Corporation for Atmospheric Research/Unidata

HDF EOS Library
Copyright © 1996 Hughes and Applied Research Corporation

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyrighted by DataDirect Technologies, 1991-2003.

Portions of this software were developed using Unisearch's Kakadu software, for which Kodak has a commercial license. Kakadu 
Software. Copyright © 2001. The University of New South Wales, UNSW, Sydney NSW 2052, Australia, and Unisearch Ltd, 
Australia. 

Portions of this computer program are copyright © 1995-1999 LizardTech, Inc. All rights reserved. MrSID is protected by U.S. Patent 
No. 5,710,835. Foreign Patents Pending.

Portions of this software are copyrighted by Merge Technologies Incorporated.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/)

IDL Wavelet Toolkit Copyright © 2002 Christopher Torrence.

Other trademarks and registered trademarks are the property of the respective trademark holders.

getstart.book  Page 2  Tuesday, June 14, 2005  12:07 PM



getstart.book  Page 3  Tuesday, June 14, 2005  12:07 PM
Contents
Chapter 1
The Power of IDL ................................................................................... 11
Using this Manual ...........................................................................................................  15

Chapter 2
The IDL Interface ................................................................................... 17
Starting IDL .....................................................................................................................  18
Using the IDL Development Environment .....................................................................  19

Menu Bar ..................................................................................................................  20
Toolbars ....................................................................................................................  20
Project Window ........................................................................................................  20
Multiple Document Panel .........................................................................................  21
Command Line .........................................................................................................  22
Output Log ................................................................................................................  23
Variable Watch Window ..........................................................................................  23
Status Bar ..................................................................................................................  23
Getting Started with IDL 3



4

getstart.book  Page 4  Tuesday, June 14, 2005  12:07 PM
The IDL iTools ................................................................................................................ 24
Starting an iTool ........................................................................................................ 25
Loading Data into an iTool ....................................................................................... 25
The iTools Data Manager .......................................................................................... 26

Quitting IDL ..................................................................................................................... 27
More About Using IDL .................................................................................................... 28

Chapter 3
Reading and Writing Data ....................................................................  29
IDL and Reading and Writing Data ................................................................................. 30
IDL Supported Formats ................................................................................................... 31
Importing Data from an ASCII File ................................................................................. 32
Reading and Writing Binary Data .................................................................................... 33
Reading and Writing Images ........................................................................................... 34

Importing Image Data into an iTool .......................................................................... 34
Importing Image Data at the Command Line ............................................................ 35

More About IDL and Input/Output .................................................................................. 36

Chapter 4
2-D Plots ................................................................................................  37
IDL and 2-D Plotting ....................................................................................................... 38
Using the iPlot Tool ......................................................................................................... 39

Displaying a 2D Plot ................................................................................................. 39
Displaying an Overplot ............................................................................................. 40
Modifying Plots ......................................................................................................... 42

Simple Command Line Plotting ....................................................................................... 43
Using OPLOT ............................................................................................................ 44
Printing a Plot ............................................................................................................ 44

Plotting with Data Sets ..................................................................................................... 46
Other Plotting Capabilities ............................................................................................... 48
More About 2-D Plotting ................................................................................................. 49

Chapter 5
Signal Processing with IDL ..................................................................  51
IDL and Signal Processing ............................................................................................... 52
Creating a Data Set .......................................................................................................... 53
Signal Processing with SMOOTH ................................................................................... 56
Contents Getting Started with IDL



5

getstart.book  Page 5  Tuesday, June 14, 2005  12:07 PM
Frequency Domain Filtering ...........................................................................................  57
Displaying the Results .....................................................................................................  60
More About Signal Processing ........................................................................................  62

Chapter 6
Images .................................................................................................... 63
IDL and Images ...............................................................................................................  64
Using the iImage Tool .....................................................................................................  65

Displaying an Image .................................................................................................  65
Modifying Images .....................................................................................................  66

Image Data and the Command Line ................................................................................  67
Reading Image Data ..................................................................................................  67
Displaying Image Data .............................................................................................  67

Resizing an Image ...........................................................................................................  70
Resizing a Graphics Window ..........................................................................................  72
Contrast Enhancement .....................................................................................................  73

Thresholding .............................................................................................................  73
Scaling Pixel Values .................................................................................................  76

Smoothing and Sharpening .............................................................................................  79
Unsharp Masking ......................................................................................................  79
Sharpening Images with Differentiation ...................................................................  80

Other Image Manipulations .............................................................................................  83
Rotating an Image .....................................................................................................  83

Extracting Profiles ...........................................................................................................  85
More About Images in IDL .............................................................................................  86

Chapter 7
Surfaces and Contours ......................................................................... 87
Surfaces and Contours in IDL .........................................................................................  88
Accessing Binary Surface Data .......................................................................................  89
Using the iSurface Tool ...................................................................................................  90

Displaying a Surface .................................................................................................  90
Modifying Surfaces ...................................................................................................  91

Using the iContour Tool ..................................................................................................  92
Displaying a Contour ................................................................................................  92
Modifying a Contour ................................................................................................  93

Surface Data and the Command Line ..............................................................................  94
Getting Started with IDL Contents



6

getstart.book  Page 6  Tuesday, June 14, 2005  12:07 PM
Displaying a Shaded Surface ..................................................................................... 95
Contour Data and the Command Line ........................................................................... 100

Displaying a Contour ............................................................................................... 100
Plotting with SHOW3 .................................................................................................... 105
More About Surfaces and Contours ............................................................................... 106

Chapter 8
Volume Visualization ..........................................................................  107
IDL and Volume Visualization ...................................................................................... 108
Using the iVolume Tool ................................................................................................. 109

Displaying a Volume ............................................................................................... 109
Modifying Volume Data ......................................................................................... 111

Command Line Volume Visualization .......................................................................... 112
Reading in a Dataset for Visualization .................................................................... 112
3-D Transformations ............................................................................................... 113
Visualizing an Iso-Surface ...................................................................................... 114

Volume Slices and the IDL Slicer ................................................................................. 117
Displaying a Surface with the Slicer .............................................................................. 119

Dismiss the Slicer and Volume Windows ............................................................... 120
More About Volume Visualization ................................................................................ 121

Chapter 9
Mapping ...............................................................................................  123
IDL and Mapping ........................................................................................................... 124
Using the iMap Tool ...................................................................................................... 125

Displaying a Map .................................................................................................... 125
Modifying Map Data ............................................................................................... 125

Drawing Map Projections .............................................................................................. 126
Drawing an Orthographic Projection ............................................................................. 129
Plotting a Portion of the Globe ...................................................................................... 131
Plotting Data on Maps ................................................................................................... 132
Reading Latitudes and Longitudes ................................................................................. 134
Plotting Contours Over Maps ........................................................................................ 135
Warping Images to Maps ............................................................................................... 137
More About Mapping .................................................................................................... 142
Contents Getting Started with IDL



7

getstart.book  Page 7  Tuesday, June 14, 2005  12:07 PM
Chapter 10
Plotting Irregularly-Gridded Data ....................................................... 143
Irregularly Gridded Data in IDL ...................................................................................  144
Creating a Dataset .........................................................................................................  145
The TRIANGULATE Procedure ..................................................................................  147
Plotting the Results with TRIGRID ..............................................................................  149
More About Gridding ....................................................................................................  151

Chapter 11
Animation ............................................................................................. 153
IDL and Animation .......................................................................................................  154
Animating a Series of Images .......................................................................................  155
Displaying an Animation as a Wire Mesh .....................................................................  157
Animation with XINTERANIMATE ............................................................................  160

Cleaning Up the Animation Windows ....................................................................  161
More About Animation .................................................................................................  162

Chapter 12
Programming in IDL ............................................................................ 163
IDL and Programming ...................................................................................................  164
Programming Capabilities of the IDLDE ......................................................................  165

Built-In Editor .........................................................................................................  165
Types of IDL Programs ..........................................................................................  165
Compound Statements ............................................................................................  166
Conditional Statements ...........................................................................................  166
Loop Statements .....................................................................................................  166
Jump Statements .....................................................................................................  167

Executing a Simple IDL Program .................................................................................  168
Saving, Compiling and Running .............................................................................  169

Debugging Tools in IDL ...............................................................................................  170
Breakpoints .............................................................................................................  170
Variable Watch Window ........................................................................................  170
The IDL Code Profiler ............................................................................................  171

Using IDL Projects ........................................................................................................  172
Accessing All Application Files .............................................................................  172
Working with Project Files .....................................................................................  173
Compiling and Running Applications ....................................................................  173
Getting Started with IDL Contents



8

getstart.book  Page 8  Tuesday, June 14, 2005  12:07 PM
Building Distributions ............................................................................................. 173
Exporting Applications ............................................................................................ 173

More About IDL Programming ..................................................................................... 174

Chapter 13
Manipulating Data ...............................................................................  175
IDL and Manipulating Data ........................................................................................... 176
IDL Array Routines ....................................................................................................... 177
Avoiding IF Statements for Performance ...................................................................... 178

Summing to Avoid IF Statements ........................................................................... 178
Using Array Operators and the WHERE Function ................................................. 178
Example— Using Vector and Array Operations ..................................................... 179

More About Manipulating Data ..................................................................................... 181

Chapter 14
Creating Interfaces with the IDL GUIBuilder ....................................  183
What is the IDL GUIBuilder? ........................................................................................ 184

Using the IDL GUIBuilder ...................................................................................... 184
IDL GUIBuilder Tools ................................................................................................... 186

Using the IDL GUIBuilder Toolbar ........................................................................ 186
Creating an Example Application .................................................................................. 187

Defining Menus for the Top-Level Base ................................................................. 187
Running the Application in Test Mode ................................................................... 191
Generating the IDL Code ........................................................................................ 191
Handling the Open File Event ................................................................................. 192
Handling the Exit Event .......................................................................................... 193
Handling the Load Color Table Event .................................................................... 194
Handling the Smooth Event .................................................................................... 194
Compiling and Running the Example Application ................................................. 195

Widget Types ................................................................................................................. 197
Widget Properties .................................................................................................... 198

More About the IDL GUIBuilder .................................................................................. 199

Chapter 15
Where to Go From Here .....................................................................  201
Learning More about IDL .............................................................................................. 202

IDL Documentation Set ........................................................................................... 202
Contents Getting Started with IDL



9

getstart.book  Page 9  Tuesday, June 14, 2005  12:07 PM
Online Help .............................................................................................................  204
Online Manuals .......................................................................................................  205

IDL Demo Applications and Examples .........................................................................  206
Contacting RSI ..............................................................................................................  207

Address ...................................................................................................................  207
Phone ......................................................................................................................  207
Fax ..........................................................................................................................  207
E-mail ......................................................................................................................  207
World Wide Web ....................................................................................................  207

Index ..................................................................................................... 209
Getting Started with IDL Contents



10

getstart.book  Page 10  Tuesday, June 14, 2005  12:07 PM
Contents Getting Started with IDL



getstart.book  Page 11  Tuesday, June 14, 2005  12:07 PM
Chapter 1

The Power of IDL
IDL, the Interactive Data Language, is the ideal software for data analysis, 
visualization, and cross-platform application development. IDL integrates a 
powerful, array-oriented language with numerous mathematical analysis and 
graphical display techniques, thus giving you incredible flexibility. A few lines of 
IDL can do the job of hundreds of lines of C or Fortran, without losing flexibility or 
performance. A fourth-generation language, IDL is radically more compact than C or 
Fortran. Using IDL, tasks that require days or weeks of programming with traditional 
languages can be accomplished in hours. Users can explore data interactively using 
IDL commands and then create complete applications by writing IDL programs.
Getting Started with IDL 11
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Create Data - Use IDL to 
create data, using a complete, 
structured language that can be 
used interactively and on 
sophisticated functions, 
procedures, and applications.

Create Applications - Use the 
IDLDE (IDL Development 
Environment) to compile and 
execute commands 
immediately. It also includes 
built-in editing and debugging 
tools that provide instant 
feedback and “hands-on” 
interaction.

Read and Write Data - Use IDL to 
read and write almost any kind of 
data. Support is provided for common 
image standards and scientific data 
formats. If you have data, you can 
read it into IDL!

Visualize Data with the iTools - Use 
IDL’s iTools for your data visualization 
needs including plots, images, contours, 
surfaces volumes, and maps.
Getting Started with IDL
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Signal Processing - Use IDL 
Signal Processing techniques to 
process a variety of 1-D signals, 
from traditional filtering and 
transform operations to statistical 
methods such as prediction 
analysis.

Image Processing - Use IDL Image 
Processing techniques to filter out 
noise and to highlight true data 
characteristics and expose anomalies.

Mapping Capabilities - Use IDL 
Mapping techniques to plot data 
over different projections of the 
globe.

Irregularly-Sampled Data - Use 
IDL to easily fit irregularly-sampled 
data to a regular grid. This 
regularly-gridded data can then be 
sent to IDL’s plotting routines.
Getting Started with IDL
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Animate Images - Use IDL 
Animation tasks to visualize 
your data dynamically and to 
create an array of images and 
play them back as an animated 
sequence.

Create Applications - Use 
IDL to write sophisticated 
programs and applications 
using a complete set of 
program-control statements.
Getting Started with IDL
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Using this Manual

The chapters included in this manual provide a “hands-on” way to learn basic IDL 
concepts and techniques. Getting Started with IDL demonstrates a number of 
common IDL applications: reading and writing data, 2-D plotting, signal processing, 
surface and contour plotting, image processing, volume visualization, mapping, 
plotting irregularly-gridded data, animation, programming in IDL, manipulating data, 
IDL Toolkits, and use of IDL’s GUIBuilder. Each section introduces basic IDL 
concepts and highlights some of the commonly used IDL commands.

You don’t have to read all of the descriptive passages that accompany each chapter. 
Simply enter the IDL commands shown in courier type at the IDL Command Line 
(the “IDL>” prompt) and observe the results. Unless otherwise noted, each line 
shown is a complete IDL command (press RETURN after typing each command). If 
you want more information about a specific command, you can read the explanations.

Each chapter functions similarly to a tutorial and is a demonstration of a particular 
IDL feature. It is recommended that you walk through each short, interactive chapter 
to preserve continuity, since many commands rely upon previous commands. Each 
chapter assumes the most basic level of IDL experience.

Note
The examples and graphics in this manual have been captured using the Windows 
platform. Where needed, explanations have been provided for use of the examples 
on UNIX or Macintosh platforms.

Note
The dollar sign ($) at the end of the first line is the IDL continuation character. It 
allows you to enter long IDL commands as multiple lines.

Note
To simplify obtaining useful results from the examples in this manual, create a 
bitmap buffer for your graphic windows and use a maximum of 256 colors by 
entering the following command at the IDL command prompt:

DEVICE, RETAIN=2, DECOMPOSED=0
Getting Started with IDL Using this Manual
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Chapter 2

The IDL Interface
This chapter introduces the IDL Development Environment and its capabilities.
Starting IDL . . . . . . . . . . . . . . . . . . . . . . . . .  18
Using the IDL Development Environment  .  19
The IDL iTools  . . . . . . . . . . . . . . . . . . . . . .  24

Quitting IDL . . . . . . . . . . . . . . . . . . . . . . . .  27
More About Using IDL  . . . . . . . . . . . . . . .  28
Getting Started with IDL 17
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Starting IDL

To start IDL, follow the instructions according to your Operating System:

• Windows - Click the Windows Start button, and select: 

Programs → RSI IDL 6.2 → IDL.

• Macintosh - IDL 6.2 for MacOS X can only be run from a UNIX X-Windows 
prompt. In order to obtain an X-Windows prompt, it is necessary to start the 
Apple X11 window manager. Launch X11 from the Applications folder. X11 
displays a UNIX X-Windows command line in an OS X window. Now at the 
system command prompt enter:

idlde

• Motif - Start IDL by entering the following at the % prompt: 

idlde

Note
For more information on installing and licensing IDL, see the IDL installation 
instructions for your platform.
Starting IDL Getting Started with IDL
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Using the IDL Development Environment

IDL’s multiple-document interface is called the IDL Development Environment 
(IDLDE) and includes built-in editing and debugging tools. The IDL Development 
Environment is available for use on the Windows, Macintosh, and Motif (UNIX) 
platforms.

Note
All figures shown in this chapter are Windows environment figures but the IDLDE 
is similar on each of the other platforms. Simply open the IDLDE in your 
environment and follow along with the descriptions of IDLDE features.

Note
A command line interface is also available on UNIX and Macintosh platforms. For 
more information, see the Using IDL manual.

When you start IDL, the IDL Development Environment appears:  

Figure 2-1: The IDL Development Environment (Shown in Windows OS)

Menu Bar

Tool Bar

 

Status Bar

Variable Watch
Window

Command Line

Multiple 
Document

Project Window

Panel

Output Log
Getting Started with IDL Using the IDL Development Environment
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Menu Bar

The menu bar, located at the top of the main IDLDE window, allows you to control 
various IDLDE features. When you select an option from a menu item in the IDLDE, 
the Status Bar displays a brief description.

You can display menu commands for each menu using the following methods:

• Clicking the menu on the Menu bar.

• Pressing the Alt key plus the underlined letter in the menu’s title. For example, 
to display the File menu, press Alt+F.

You can select or execute a menu command using the following methods:

• Clicking the item in the menu. 

• Pressing the Alt key plus the underlined letter in the menu’s title, and then 
pressing the letter underlined in the menu item. For example, to select the 
menu item File → Open, press Alt+F+O.

• Using the cursor and the arrow keys to highlight a menu item, and then 
pressing the Enter key.

Note
Many items (on each platform) have keyboard shortcuts displayed to the right of the 
corresponding menu option.

Toolbars

There are three toolbars in the IDLDE: Standard, Run & Debug, and Macros. In 
addition, when you open an IDL GUIBuilder window (Windows only), its associated 
toolbar is displayed. When you position the mouse pointer over a toolbar button, the 
Status Bar displays a brief description. If you click on a toolbar button which 
represents an IDL command, the IDL command issued is displayed in the Output 
Log. Display or hide toolbars by making selections among the Windows → 
Toolbars items.

Project Window

The Project Window displays information about the current Project you have open in 
the IDLDE. IDL Projects allow you to easily develop applications in IDL. Through a 
Project, you can compile, run, and create distributions of your IDL application. The 
IDL Project Window allows you to access and manage all of the files required for 
Using the IDL Development Environment Getting Started with IDL
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your application. This makes it easier to create a distribution for other developers, 
colleagues, or users. 

Multiple Document Panel

The section of the main IDL window where IDL Editor windows and GUIBuilder 
windows are displayed is known as the multiple document panel. Any number of files 
may be open at a single time. You can access different files from the Windows menu 
by clicking on the appropriate file.

Editor Windows

IDL Editor windows allow you to write and edit IDL programs (and other text files) 
from within IDL. Any number of Editor windows can exist simultaneously. No 
Editor windows are open when IDL is first started. Editor windows can be created by 
selecting File → New or File → Open. See “Maximizing the Editor’s Capabilities” 
in Chapter 2 of the Building IDL Applications manual for more information on the 
IDL Editor. 

To see the Multiple Document Panel at work, open the file examples.pro by typing 
.COMPILE examples.pro at the IDL command line. (See “Command Line” on 
page 57 for details.)

The following figure shows the IDL program file opened in the Windows IDLDE.

GUIBuilder Windows 

Under Microsoft Windows, IDL GUIBuilder windows allow you to interactively 
create user interfaces. Then, you can generate the IDL code that defines the interface 
and the code to contain the event-handling routines. You can modify the code, 
compile, and run the application in the IDLDE. To open a GUIBuilder window, you 
can select File → New → GUI or you can select File → Open. See Chapter 29, 

Figure 2-2: Editor Window showing example.pro
Getting Started with IDL Using the IDL Development Environment
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“Using the IDL GUIBuilder” in the Building IDL Applications manual. for more 
information on the GUIBuilder.

Graphics Windows

IDL Graphics windows are not displayed in the Multiple Document Panel, but do 
appear when you use IDL to plot or display data. You can copy the contents of a 
Graphics window—iTool, Object or Direct—directly to the operating system 
clipboard in a bitmap format using CTRL+C. 

When an IDL Graphics window is minimized (iconized), the icon displays the name 
of the IDL window. This icon appears on the desktop, not in the Multiple Document 
Panel, as with an iconized Editor window. 

Warning
If the backing store is not set when a window is iconized, it will not be refreshed 
upon return. For more information about setting the backing store for graphics 
windows, see “Graphics Preferences” on page 104.

Command Line

The Command Line is an IDL prompt where you can enter IDL commands. The text 
output by IDL commands is displayed in the Output Log window. IDL is an 
interpreted language and commands entered at the Command Line are executed 
immediately. To see the IDL Command Line in action, enter the following in the 
Command Line at the IDL prompt and press Enter: 

print, 'Hello World!'

If you click the right mouse button while positioned over the Command Input Line, a 
popup menu appears displaying the command history, with a default buffer of 20 
entries and a maximum of 100 entries. Select an entry to reissue the command. See 
“Recalling Commands” in Chapter 2 of the Building IDL Applications manual for 
additional information about the command recall buffer.

Figure 2-3: IDLDE Command Line
Using the IDL Development Environment Getting Started with IDL
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Output Log

Output from IDL is displayed in the Output Log window, which appears by default 
when the IDLDE is first started. Notice the result of our print command in the Output 
Log in the following figure.

If you click the right mouse button while positioned over the Output Log, a context 
menu appears allowing you to move to a specified error or clear the contents of the 
Output Log. An additional Windows-only context menu option allows you to copy 
selected contents.

Variable Watch Window

The Variable Watch window appears by default when you start the IDLDE. It keeps 
track of variables as they appear and change during program execution (tabs exist for 
viewing variables by type; Locals, Params, Common and System). For more 
information about the Variable Watch window, see “The Variable Watch Window” 
in Chapter 8 of the Building IDL Applications manual.

Status Bar

When you position the mouse pointer over a Control Panel or Toolbar button, or 
select an option from a menu in IDLDE, the Status Bar displays a brief description.

Figure 2-4: The IDL Output Log
Getting Started with IDL Using the IDL Development Environment
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The IDL iTools

The IDL Intelligent Tools (iTools) are a set of interactive utilities that combine data 
analysis and visualization with the task of producing presentation quality graphics. 
Based on the IDL Object Graphics system, the iTools are designed to help you get the 
most out of your data with minimal effort. They allow you to continue to benefit from 
the control of a programming language, while enjoying the convenience of a point-
and-click environment. Each tool is designed around a specific visualization type:

• Two and three dimensional plots (line, scatter, polar, and histogram style)

• Surface representations

• Contour maps

• Image displays

• Volume visualizations

• Maps

Figure 2-5: Black Hole Density Data in the iVolume Tool
The IDL iTools Getting Started with IDL
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For detailed information on the new iTools and how to use them, see the iTool User’s 
Guide.

The iTools are built upon an object-oriented framework, or set of object classes, that 
serve as the building blocks for their interface and functionality. IDL programmers 
can easily use this framework to create custom data analysis and visualization 
environments. Such custom Intelligent Tools may be called from within a larger IDL 
application, or they may serve as the foundation for a complete application in 
themselves. For more information on creating your own custom iTools, see the iTool 
Developer’s Guide.

Starting an iTool

To get started using the new IDL iTools, from the IDLDE command line, simply type 
the name of the tool you wish to call. The tools available are:

• iContour

• iImage

• iPlot

• iSurface

• iVolume

• iMap

You can also launch an iTool using these other methods:

• From Windows:

Start → Programs → RSI IDL 6.1 → iTools → iTool Name

• From the IDLDE:

File → New → Visualization → iTool Name

Loading Data into an iTool

There are multiple options for loading your data into your chosen iTool for 
visualization:

• Command Line Argument — At the IDL Command Line enter: 

mydata = RANDOMU(SEED, 45)
iPlot, mydata 

This option allows you to have control over parameters and keyword options 
for setting up the way you wish your plot (or other visualization) to appear.
Getting Started with IDL The IDL iTools
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• File → Open  — The quickest way to create a default visualization of your 
data.

• File → Import → IDL variable — This will invoke the IDL Import wizard.

• File → Import → From a File -— This also invokes the IDL Import wizard.

• Insert → Visualization — This method gives you parameter control similar to 
using the command line.

Note
For more detailed information on loading data into the iTools, see Chapter 2, 
“Importing and Exporting Data” in the iTool User’s Guide manual.

The iTools Data Manager

All data used by any iTool is first loaded into the iTools Data Manager, which keeps 
track of which data items are associated with an iTool visualization. The Data 
Manager provides a convenient and structured environment in which to import and 
view files and variables.

The process of loading data into the Data Manager is entirely automatic if you 
specify data when launching an iTool at the IDL command line or if you open a data 
file using the Open command from the iTool’s File menu. In these cases, the iTool 
will import the data in the specified file or variable and create a visualization of the 
default type for the selected data and the iTool you are using.

If you want more control over the process of creating a visualization, you can load 
data into the Data Manager manually, either from a data file or from one or more 
variables that exist in your current IDL session. Once a data item is placed in the Data 
Manager, it is available to all iTools until it is removed.
The IDL iTools Getting Started with IDL
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Quitting IDL

To quit the current IDL session and return to the operating system, select File → Exit 
in the IDL Development Environment. You can also type EXIT at the IDL Command 
Line:

IDL>EXIT
Getting Started with IDL Quitting IDL
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More About Using IDL

This overview has acquainted you with the very basic layout and function of the IDL 
Development Environment and the basic functions of the IDL iTools. More in-depth 
information on working with IDL and the IDL Development Environment (IDLDE) 
can be found in Using IDL and more information on the iTools can be found in the 
iTool User’s Guide.
More About Using IDL Getting Started with IDL



getstart.book  Page 29  Tuesday, June 14, 2005  12:07 PM
Chapter 3

Reading and Writing 
Data
This chapter introduces IDL’s ability to read and write data.
IDL and Reading and Writing Data . . . . . . .  30
IDL Supported Formats . . . . . . . . . . . . . . . .  31
Importing Data from an ASCII File  . . . . . .  32

Reading and Writing Binary Data  . . . . . . .  33
Reading and Writing Images  . . . . . . . . . . .  34
More About IDL and Input/Output  . . . . . .  36
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30 Chapter 3: Reading and Writing Data

getstart.book  Page 30  Tuesday, June 14, 2005  12:07 PM
IDL and Reading and Writing Data

IDL’s flexible input and output capabilities allow you to read and write virtually any 
data format. When IDL reads a data file, bytes or characters in the file are converted 
to the appropriate data type (unless the file is binary, in which case no conversion 
takes place). Similarly, when writing data, the appropriate IDL variables are 
converted to the appropriate bytes or characters. In this chapter, you’ll import some 
existing data using IDL commands.

Note
To simplify obtaining useful results from the examples in this manual, create a 
bitmap buffer for your graphic windows and to use a maximum of 256 colors by 
entering the following command at the IDL command prompt:

DEVICE, RETAIN=2, DECOMPOSED=0
IDL and Reading and Writing Data Getting Started with IDL
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IDL Supported Formats

IDL supports a wide variety of scientific and image file formats. See “Supported File 
Formats” in Chapter 1 of the Using IDL manual for a complete list. 
Getting Started with IDL IDL Supported Formats
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Importing Data from an ASCII File

You can import ASCII data into IDL directly at the command line or also using the 
iTools if you need to visualize data in plot, surface, contour, image or volume form. 
Whether reading in directly or through the iTools you will need to read in the ASCII 
data in using IDL’s interactive wizard for importing ASCII data, known as the ASCII 
Template.

For information on the various ways you can read ASCII data using IDL, see 
“Reading ASCII Data” in Chapter 6 of the Using IDL manual.
Importing Data from an ASCII File Getting Started with IDL
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Reading and Writing Binary Data

Reading data files into IDL is easy if you know the format in which the data is stored. 
Often, images are stored as arrays of bytes instead of a known format like JPEG or 
TIFF. These files we’ll refer to as “Binary” files. You can import binary data into 
IDL directly at the command line or also using the iTools if you need to visualize 
data in plot, surface, contour, image or volume form. Whether reading in directly or 
through the iTools you will need to read the binary data in using IDL’s interactive 
wizard for importing binary data, known as the Binary Template. 

For information on the various ways you can read binary data using IDL, see 
“Reading Binary Data” in Chapter 6 of the Using IDL manual.
Getting Started with IDL Reading and Writing Binary Data
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Reading and Writing Images

You can import image data into IDL directly at the command line or also using the 
iImage tool.

Importing Image Data into an iTool

The iTools are fully interactive and automatically read your image data.

Here is an example of opening an image file in iImage:

1. From the iImage window, select File → Open and from the examples\data 
directory choose a file named image.tif.

2. Select Open, and the file is displayed in iImage.

Figure 3-1: Image.tif Displayed in iImage
Reading and Writing Images Getting Started with IDL
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Importing Image Data at the Command Line

Reading image files directly into IDL is easy if you know the format in which the 
image is stored. First we must read in the image. Here we will use a TIFF format 
image of an aerial satellite view of Manhattan Island in New York City. 

1. Enter the following at the IDL Command Line to read the file into memory:

MYIMAGE=READ_TIFF(FILEPATH('image.tif',SUBDIR= $
['examples', 'data']))

2. Now display the image:

TV, MYIMAGE

Note
Another way to import image data is to use the Import Image File toolbar 
button on the IDLDE toolbar. To use this feature simply click the button and 
the dialog will appear so that you may select “image.tif”. However, this will 
name the image differently than shown in this example.

3. Now, using IDL’s WRITE_TIFF command, rename and write the file:

WRITE_TIFF, 'imagecopy.tif', MYIMAGE

Figure 3-2: Reading and displaying an image file
Getting Started with IDL Reading and Writing Images



36 Chapter 3: Reading and Writing Data

getstart.book  Page 36  Tuesday, June 14, 2005  12:07 PM
More About IDL and Input/Output

For more examples of using IDL’s input/output capabilities, see Chapter 6, 
“Importing and Writing Data into Variables” in the Using IDL manual. For more 
information about the iTools’ input/output capabilities, see the iTool User’s Guide. 
Also, for list of the input and output routines provided by IDL, see the category for 
“Input/Output” in the IDL Quick Reference manual.
More About IDL and Input/Output Getting Started with IDL
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Chapter 4

2-D Plots
This chapter describes the following topics:
IDL and 2-D Plotting . . . . . . . . . . . . . . . . . .  38
Using the iPlot Tool . . . . . . . . . . . . . . . . . . .  39
Simple Command Line Plotting  . . . . . . . . .  43

Plotting with Data Sets . . . . . . . . . . . . . . . .  46
Other Plotting Capabilities . . . . . . . . . . . . .  48
More About 2-D Plotting . . . . . . . . . . . . . .  49
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IDL and 2-D Plotting

IDL makes plotting data easy. X versus Y plots can be displayed with a single 
command, and multiple plots can be viewed at the same time. You can also use the 
new IDL iPlot tool to visualize and manipulate your plot data. This chapter 
demonstrates some of IDL’s plotting capabilities. We will also examine how you 
enter statements at the IDL Command Line and how to use the iPlot tool. This 
demonstrates IDL’s interactive capability, and shows how easy it is to manipulate 
your data.

Note
To simplify obtaining useful results from the command line examples in this 
manual, create a bitmap buffer for your graphic windows and to use a maximum of 
256 colors by entering the following command at the IDL command prompt:

DEVICE, RETAIN=2, DECOMPOSED=0
IDL and 2-D Plotting Getting Started with IDL
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Using the iPlot Tool

The iPlot tool’s primary design is to display plot data, though the tool is capable of 
much more once the data is plotted. The iPlot tool can display multiple types of plots 
and allows you to manipulate and edit the displays. 

Displaying a 2D Plot

The first task is to display plot data. Here is a simple example of how to display a 
plot.

At the IDL command line, enter:

iPlot, RANDOMU(seed, 20)

Figure 4-1: A Simple 2D Plot Using the iPlot Tool
Getting Started with IDL Using the iPlot Tool
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Displaying an Overplot

Once you have plotted data, you may overplot new plot data in the original iPlot 
window. Overplotting is the process of plotting new data over the top of original data 
or datasets for the purpose of analyzing or comparing more than one dataset at a time.

For example, in order to overplot cosine data onto a plot of sine wave data follow 
these steps:

1. Create a variable named “theory” to contain sine wave data to be plotted:

theory = SIN(2.0*FINDGEN(200)*!PI/25.0)*EXP(-0.02*FINDGEN(200))

2. Plot theory using iPlot:

iPlot, theory 

Figure 4-2: Sin Wave Data Plotted
Using the iPlot Tool Getting Started with IDL
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3. Create a variable named “newtheory” which stores cosine data to be used for 
overplotting:

newtheory = COS(2.0*FINDGEN(200)*!PI/25.0)*EXP(-0.02*FINDGEN(200))

4. Now overplot the new cosine data onto your original plot:

iPlot, newtheory, /OVERPLOT

Note
 You can also overplot in the iPlot tool any other way you can load new data into 
the existing iPlot tool (for example, using File → Open).

Figure 4-3: Cosine Data Overplotted on Sine Data
Getting Started with IDL Using the iPlot Tool
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Modifying Plots

The iPlot tool allows you many options for modifying and manipulating your plots, 
such as displaying 3D plots, displaying polar plots, adding error bars, legends, 
colorbars, curve fitting, filtering, and annotating among other things. For much more 
information on working with the iPlot tool, see Chapter 13, “Working with Plots” in 
the iTool User’s Guide manual.
Using the iPlot Tool Getting Started with IDL
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Simple Command Line Plotting

Simple plots can be charted using the PLOT procedure. Each call to PLOT 
establishes the plot window (the rectangular area enclosed by the axis), the plot 
region (the box enclosing the plot window and its annotation), the axis types (linear 
or logarithmic), and the scaling. 

First, we’ll plot a simple graph using a sine function. Use the FINDGEN function 
here to specify the dimensions of the array. The FINDGEN function returns a single-
precision, floating-point array, with the specified dimension, where each element of 
the array is set to the value of its one-dimensional subscript.

1. First, create a value for the X axis:

X= 2*!PI/100 * FINDGEN(100)

2. Now, use PLOT to visualize the array:

PLOT, SIN(X)

Also, additional data can be added, as before, using the OPLOT procedure. 
Frequently, the color index, linestyle, or line thickness parameters are changed in 
each call to OPLOT to distinguish the data sets. The IDL Reference Guide contains a 
table describing the features you can change.

Figure 4-4: A simple sine wave using the PLOT command
Getting Started with IDL Simple Command Line Plotting
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Using OPLOT

Now use OPLOT to plot the new information over the existing plot:

1. Plot at twice the frequency:

OPLOT, SIN(2*X)

2. Plot at three times the frequency:

OPLOT, SIN(3*X)

The results are shown in the following figure.

Printing a Plot

IDL allows you to easily print the plot just created. Simply enter the following 
command lines shown.

1. First, save the original settings of your plotting environment:

MYDEVICE=!D.NAME

2. Tell IDL that you wish to designate the printer to be the destination for the 
plot:

SET_PLOT, 'printer'

3. Now plot again to the printer:

Figure 4-5: Graphing various data using the OPLOT command
Simple Command Line Plotting Getting Started with IDL
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PLOT, SIN(X)

4. Close the printing device:

DEVICE, /CLOSE

5. Redesignate the original setting as the future destination for any plots:

SET_PLOT, MYDEVICE

Note
If you are having problems printing on UNIX, be sure your printer is configured 
correctly. For more information on this see “IDL Printer Setup in UNIX or Mac OS 
X” in Chapter 2 of the Using IDL manual.
Getting Started with IDL Simple Command Line Plotting
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Plotting with Data Sets

To demonstrate IDL’s capability to read a data set and plot it, we will create and use 
and ASCII template. 

1. At the IDL command line, enter the following to create the variable 
plotTemplate, which will contain your custom ASCII template: 

plotTemplate = ASCII_TEMPLATE( )

A dialog box appears, prompting you to select a file.

2. Select the plot.txt file in the examples/data subdirectory of the IDL 
distribution.

Note
Another way to import ASCII data is to use the Import ASCII File toolbar 
button on the IDLDE toolbar. To use this feature, simply click the button and 
select plot.txt from the file selection dialog.

3. After selecting the file, the Define Data Type/Range dialog appears. First, 
choose the field type. Since the data file is delimited by tabs (or whitespace) 
select the Delimited button. In the Data Starts at Line field, specify to begin 
reading the data at line 3, not line 1, since there are two comment lines at the 
beginning of the file. Click Next to continue.

4. In the Define Delimiter/Fields dialog box, select Tab as the delimiter between 
data elements since it is known that tabs were used in the original file. Click 
Next.

5. In the Field Specification dialog box, name each field as follows: 

• Click on the first row (row 1). In the Name field, enter time.

• Select the second row and enter temperature1. 

• Select the third row and enter temperature2. 

6. Click Finish.

7. Type the following line at the IDL command line to read in the plot.txt file 
using the custom template, plotTemplate:

PLOT_ASCII = READ_ASCII(FILEPATH('plot.txt', SUBDIRECTORY= $
['examples', 'data']), TEMPLATE=plotTemplate)

8. Plot the first set of data on temperatures which is stored in Temp1:

PLOT, PLOT_ASCII.TIME, PLOT_ASCII.temperature1
Plotting with Data Sets Getting Started with IDL
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Note
The file is read into a structure variable. For more information on accessing ASCII 
data, see “Reading ASCII Data” in Chapter 6 of the Using IDL manual.

Figure 4-6: Plotting an existing data set using PLOT
Getting Started with IDL Plotting with Data Sets
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Other Plotting Capabilities

Now add titles to the simple plot graph using the TITLE, XTITLE, and YTITLE 
keywords. Using these simple keywords, IDL allows you to add a title to your plot as 
well as descriptive titles for your X and Y axis.

1. Plot with titles:

PLOT,PLOT_ASCII.TIME,PLOT_ASCII.Temperature1, $
TITLE='Temperature Over Time', $
XTITLE='Time in Seconds', YTITLE='Temperature Celsius'

Figure 4-7: Adding Titles to a Plot Using TITLE, XTITLE and YTITLE
Other Plotting Capabilities Getting Started with IDL



Chapter 4: 2-D Plots 49

getstart.book  Page 49  Tuesday, June 14, 2005  12:07 PM
More About 2-D Plotting

IDL has many more plotting capabilities than the ones shown in this chapter. For a 
list of plotting routines, see “Plotting” in  of the IDL Quick Reference manual. To 
take advantage of all of IDL’s powerful capabilities in creating two-dimensional 
plots, look for more information about the iPlot tool in Chapter 13, “Working with 
Plots” in the iTool User’s Guide manual, and for information about plot objects in 
Chapter 5, “Working with Plots and Graphs” in the Object Programming manual. 
Getting Started with IDL More About 2-D Plotting
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Chapter 5

Signal Processing 
with IDL
This chapter describes the following topics:
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Signal Processing with SMOOTH . . . . . . . .  56
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IDL and Signal Processing

This chapter introduces you to IDL’s digital signal processing tools. Most of the 
procedures and functions mentioned here work in two or more dimensions. For 
simplicity, only one-dimensional signals are used in the examples. 

A signal, by definition, contains information. Any signal obtained from a physical 
process also contains noise. It is often difficult or impossible to make sense of the 
information contained in a digital signal by looking at it in its raw form—that is, as a 
sequence of real values at discrete points in time. Signal analysis transforms offer 
natural, meaningful, alternate representations of the information contained in a 
signal. 
IDL and Signal Processing Getting Started with IDL
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Creating a Data Set

First, we need to create a dataset to display. 

1. Enter the following command to create a sinewave function with a frequency 
that increases over time and store it in a variable called ORIGINAL:

ORIGINAL=SIN((FINDGEN(200)/35)^2.5)

The FINDGEN function returns a floating-point array in which each element 
holds the value of its subscript, giving us the increasing “time” values upon 
which the sinewave is based. The sine function of each “time” value divided 
by 35 and raised to the 2.5 power is stored in an element of the variable 
ORIGINAL. 

2. To view a quick plot of this dataset, shown in the following, enter:

PLOT, ORIGINAL

Figure 5-1: Plot of Increasing Frequency
Getting Started with IDL Creating a Data Set
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3. Now add some uniformly-distributed random noise to this dataset and store it 
in a new variable:

NOISY=ORIGINAL+((RANDOMU(SEED,200)-.5)/ 2)

4. Now plot the array:

PLOT, NOISY

The RANDOMU function creates an array of uniformly distributed random 
values. The original dataset plus the noise is stored in a new variable called 
NOISY. This dataset looks more like real-world test data. 

Figure 5-2: Plot of Random Noise
Creating a Data Set Getting Started with IDL
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5. Display the original dataset and the noisy version simultaneously by entering 
the following commands:

PLOT, ORIGINAL, XTITLE="Time",YTITLE="Amplitude",THICK=3

6. Then overplot the previous data:

PLOT, NOISY, /OVERPLOT

The XTITLE and YTITLE keywords are used to create the X and Y axis titles. 
The OPLOT command plots the NOISY dataset over the existing plot of 
ORIGINAL without erasing. Setting the THICK keyword causes the default 
line thickness to be multiplied by the value assigned to THICK, so you can 
differentiate between the data. This result can be seen in the following figure.

Figure 5-3: Combined Plotting of Datasets
Getting Started with IDL Creating a Data Set
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Signal Processing with SMOOTH

A simple way to smooth out the NOISY dataset is to use IDL’s SMOOTH function. It 
returns an array smoothed with a boxcar average of a specified width. 

1. Create a new variable to hold the smoothed dataset by entering the following 
command:

SMOOTHED=SMOOTH(NOISY, 5)

2. Now plot your new data set:

IPLOT,SMOOTHED,TITLE='Smoothed Data'

The TITLE keyword draws the title text centered over the plot. Notice that 
while SMOOTH did a fairly good job of removing noise spikes, the resulting 
amplitudes taper off as the frequency increases.

Figure 5-4: Using the SMOOTH Command
Signal Processing with SMOOTH Getting Started with IDL
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Frequency Domain Filtering

Perhaps a better way to eliminate noise in the NOISY dataset is to use Fourier 
transform filtering techniques. Noise is basically unwanted high-frequency content in 
sampled data. Applying a lowpass filter to the noisy data allows low-frequency 
components to remain unchanged while high-frequencies are smoothed or attenuated. 
Construct a filter function by entering the following step-by-step commands:

1. Create a floating point array using FINDGEN which sets each element to the 
value of its subscript and stores it in the variable Y by entering:

Y=[FINDGEN(100),FINDGEN(100)-100]

2. Next, make the last 99 elements of Y a mirror image of the first 99 elements:

Y[101:199]=REVERSE(Y[0:98])

3. Now, create a variable filter to hold the filter function based on Y:

filter=1.0/(1+(Y/40)^10)

4. Finally, plot:

IPLOT,FILTER

Figure 5-5: Constructing a Filter Function
Getting Started with IDL Frequency Domain Filtering
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To filter data in the frequency domain, we multiply the Fourier transform of 
the data by the frequency response of a filter and then apply an inverse Fourier 
transform to return the data to the spatial domain. 

1. Now we can use a lowpass filter on the NOISY dataset and store the filtered 
data in the variable lowpass by entering:

LOWPASS=FFT(FFT(NOISY,1)*filter,-1)

2. Then plot:

IPLOT, LOWPASS

Note
Your plots may look slightly different due to the random number generator.

Figure 5-6: Using a LOWPASS Filter
Frequency Domain Filtering Getting Started with IDL
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1. The same filter function can be used as a high-pass filter (allowing only the 
high frequency or noise components through) by entering:

NOISY=ORIGINAL+((RANDOMU(SEED,200)-.5)/ 2)
HIGHPASS=FFT(FFT(NOISY,1)*(1.0-filter),-1)

2. Then plot:

IPLOT, HIGHPASS

Figure 5-7: Using a Highpass Filter
Getting Started with IDL Frequency Domain Filtering



60 Chapter 5: Signal Processing with IDL

getstart.book  Page 60  Tuesday, June 14, 2005  12:07 PM
Displaying the Results

Now look at all of the results at the same time. The plotting window can be split into 
six sections, making each section display a different plot. The system variable 
!P.MULTI tells IDL how many plots to put on a single page.

Enter the following lines to display a plotting window which shows all of the plots 
simultaneously.

1. To display all plots at the same time with two columns and three rows, enter:

!P.MULTI=[0,2,3]

2. Now, display original dataset, upper-left:

PLOT,ORIGINAL,TITLE='Original (Ideal) Data'

3. Next, display noisy dataset in the upper-right:

PLOT,NOISY,TITLE='Noisy Data'

4. Display filter function, middle-left. The SHIFT function was used to show the 
filter’s peak as centered.

PLOT,SHIFT(filter,100),TITLE='Filter Function'

5. Now, display low-pass filtered dataset in the middle-right:

PLOT,LOWPASS,TITLE='Lowpass Filtered'

6. Display high-frequency noise, lower-left:

PLOT,HIGHPASS,TITLE='Highpass Filtered'
Displaying the Results Getting Started with IDL
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7. Finally, display the SMOOTH function dataset for comparison with the low-
pass filtered data in the lower right.

PLOT, smoothed, TITLE = 'Smoothed with Boxcar average'

8. Before continuing with the rest of the chapters, reset the plotting window to 
display a single image by entering the command:

!P.MULTI = 0

Figure 5-8: Using !P.MULTI to Show Six Plots in One Plotting Window
Getting Started with IDL Displaying the Results
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More About Signal Processing

Using just a few IDL commands, we have performed some complex and powerful 
signal processing tasks. IDL has many more signal processing abilities than the ones 
shown in this chapter. To take advantage of all of IDL’s powerful capabilities, look 
for more information in Chapter 10, “Signal Processing” in the Using IDL manual 
manual.
More About Signal Processing Getting Started with IDL
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Chapter 6

Images
This chapter describes the following topics:
IDL and Images . . . . . . . . . . . . . . . . . . . . . .  64
Using the iImage Tool . . . . . . . . . . . . . . . . .  65
Image Data and the Command Line  . . . . . .  67
Resizing an Image . . . . . . . . . . . . . . . . . . . .  70
Resizing a Graphics Window  . . . . . . . . . . .  72

Contrast Enhancement  . . . . . . . . . . . . . . . .  73
Smoothing and Sharpening  . . . . . . . . . . . .  79
Other Image Manipulations  . . . . . . . . . . . .  83
Extracting Profiles  . . . . . . . . . . . . . . . . . . .  85
More About Images in IDL  . . . . . . . . . . . .  86
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IDL and Images

IDL is ideal for working with image data because of its interactive operation, uniform 
notation, and array-oriented operators and functions. Images are easily represented as 
two-dimensional arrays in IDL and can be processed just like any other array. IDL 
also contains many procedures and functions specifically designed for image display 
and processing. In addition, the iImage tool allows you great flexibility in 
manipulating and visualizing image data.

In this chapter, we will image process by entering statements at the IDL Command 
Line as well as trying out the new iImage tool. This will demonstrate IDL’s 
interactive capability, and will show how easy it is to manipulate your data.

Note
To simplify obtaining useful results from the command line examples in this 
manual, create a bitmap buffer for your graphic windows and to use a maximum of 
256 colors by entering the following command at the IDL command prompt:

DEVICE, RETAIN=2, DECOMPOSED=0

See “Image Display” (and the functional category “Image Processing” in the IDL 
Quick Reference manual) for a brief description of IDL routines for displaying and 
manipulating images. Detailed information is available in the IDL Reference Guide.
IDL and Images Getting Started with IDL
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Using the iImage Tool

The iImage tool is a powerful option for visualizing and manipulating image data. 
Unlike the command line-oriented visualizations shown previously, with iImage, a 
single command will give you a fully interactive environment. 

Displaying an Image

Using our same TIFF data, follow these steps:

1. At the IDL Command Line, enter iImage.

2. As shown in Chapter 3, “Reading and Writing Data”, select File → Open and 
from the examples\data directory choose a file named image.tif.

3. Select Open, and the file is displayed in iImage.

Figure 6-1: TIFF Data View of Manhattan in the iImage Tool
Getting Started with IDL Using the iImage Tool
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Modifying Images

The iImage tool allows you many options for modifying and manipulating your 
images, for example the Data Window on the iImage tool allows you to adjust and 
manipulate the image brightness by changing the RGA or indexed channel values. 
For indexed color images, Channel 0 represents the image data values. For RGBA 
images, Channel 0 represents the red values, Channel 1 represents the green values 
and Channel 2 represents the blue values. Within each channel is a red bar 
representing minimum values and a green bar representing maximum values. You 
can click on each bar in each channel (which are tabbed) to manipulate these values.

Other options are available in iImage such as displaying multiple images, 
manipulating image color and lighting as well as brightness and contrast, filtering, 
resampling, morphing, surfacing, adding contours, and annotating among other 
things. For much more information on working with the iImage tool, see Chapter 10, 
“Working with Images” in the iTool User’s Guide manual. The following sections 
show how to duplicate some of the iImage tool functionality at the command line 
using direct graphics. 
Using the iImage Tool Getting Started with IDL
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Image Data and the Command Line

The following sections show examples of reading and displaying image data at the 
command line.

Reading Image Data

First we must import an image to be processed into IDL. Reading image data files 
into IDL is easy whether at the command line or using the iImage tool. 

The file that we will read contains the image we used in Chapter 3, “Reading and 
Writing Data” of an aerial view above Manhattan in TIFF format.

1. Read the file by entering:

MYIMAGE=READ_TIFF(FILEPATH('image.tif',SUBDIR= $
['examples', 'data']))

Displaying Image Data

Using the IDL command line, you can view an image with two different routines. 
The TV procedure writes an array to the display as an image without scaling. Enter 
the commands below at the IDL Command Line. The TVSCL routine is another 
routine which is described following the TV routine.

Note
The default graphics window size is 640 by 512 pixels in size on a UNIX 
workstation and one-fourth of the display size on most Windows environments.

1. Display the image:

TV, MYIMAGE
Getting Started with IDL Image Data and the Command Line
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2. Enter WDELETE at the Command Line to dismiss the graphics window.

WDELETE

3. The TVSCL procedure displays the image with the color values scaled to use 
the whole color table. Display the scaled image:

TVSCL, MYIMAGE

Figure 6-2: Displaying an image with TV
Image Data and the Command Line Getting Started with IDL
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4. Enter WDELETE at the Command Line to dismiss the graphics window.

WDELETE

Figure 6-3: Displaying an image with TVSCL
Getting Started with IDL Image Data and the Command Line
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Resizing an Image

The REBIN function in IDL makes it easy to resize a vector or array to new 
dimensions. The supplied dimensions must be proportionate (that is, integral 
multiples or factors) to the dimensions of the original image. Since our original image 
array here is 768 by 512, we’ll need to decide the correct dimensions of our new 
resized image. If we want to resize the image to half the original size then simply take 
half of the array’s original dimensions.

1. Create a new image with new dimensions using the REBIN function:

NEWIMAGE=REBIN(MYIMAGE,384,256)

2. Now display the image:

TV, NEWIMAGE

3. Enter WDELETE at the Command Line to dismiss the graphics window.

WDELETE

Figure 6-4: MYIMAGE resized to one half the original array size
Resizing an Image Getting Started with IDL
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Note
The CONGRID function also shrinks or expands the size of an array. CONGRID 
differs from REBIN in that where REBIN requires that the new array size must be 
an integer multiple of the original size, CONGRID will resize an array to any 
arbitrary size. For more information, see CONGRID in the IDL Reference Guide.
Getting Started with IDL Resizing an Image
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Resizing a Graphics Window

IDL automatically creates a window for displayed graphics if one does not already 
exist. You can use the WINDOW command to create new windows with custom 
sizes.

1. To display Manhattan in a larger graphics window, enter:

WINDOW,0,XSIZE=800,YSIZE=600

2. Then enter:

TV,MYIMAGE

3. Enter WDELETE at the Command Line to dismiss the graphics window for 
the next graphic.

WDELETE

The WINDOW command above creates a new version of window number 0 that is 
800 pixels wide (specified with the XSIZE keyword) and 500 pixels tall (specified 
with the YSIZE keyword).

Figure 6-5: Visualizing a graphic through a larger graphic window
Resizing a Graphics Window Getting Started with IDL
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Contrast Enhancement

In order to improve the look of an image, sometimes all that is necessary is a change 
in how the colors are represented. IDL provides several ways to manipulate the 
contrast.

Thresholding

One of the simplest contrast enhancements that can be performed on an image is 
thresholding. Thresholding produces a two-level mapping from all of the possible 
intensities into black and white. The IDL relational operators, EQ, NE, GE, GT, LE, 
and LT, return a value of 1 if the relation is true and 0 if the relation is false. When 
applied to images, the relation is evaluated for each pixel and an image of 1’s and 0’s 
results.

1. To display the pixels in the image that have values greater than 140 as white 
and all others as black, as shown in the following, enter: 

TVSCL,MYIMAGE GT 140

Figure 6-6: Image with all values greater than 140 shown as white
Getting Started with IDL Contrast Enhancement
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2. Similarly, the pixels that have values less than 140 can be displayed as white, 
as shown, by entering the command:

TVSCL,MYIMAGE LT 140

In many images, the pixels have values that are only a small subrange of the 
possible values. By spreading the distribution so that each range of pixel 
values contains an approximately equal number of members, the information 
content of the display is maximized, as shown in the following.

Figure 6-7: Image with all values less than 140 shown as white
Contrast Enhancement Getting Started with IDL
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3. The HIST_EQUAL function performs this redistribution on an array. To 
display a histogram-equalized version of myimage, enter the following:

TV, HIST_EQUAL(myimage)

Figure 6-8: A histogram-equalized version of the image
Getting Started with IDL Contrast Enhancement
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Scaling Pixel Values

Another way to enhance the contrast of an image is to scale a subrange of pixel 
values to fill the entire range of displayed brightnesses. The > operator, the IDL 
maximum operator, returns a result equal to the larger of its two parameters. The 
following commands contrast the maximum and minimum operators.

1. Scale pixels with a value of 100 or greater into the full range of displayed 
brightnesses:

TVSCL,MYIMAGE > 100

2. Scale pixels with a value less than 140 into the full range of brightnesses.

TVSCL,MYIMAGE < 140

Figure 6-9: Image with Pixels >100 Scaled to Full Range Of Brightness
Contrast Enhancement Getting Started with IDL
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3. The minimum and maximum operators can be used together for more 
complicated contrast enhancements. Set the minimum brightness to 140, set 
the maximum brightness to 200, scale myimage and display it by entering:

TVSCL,MYIMAGE >140<200

Figure 6-10: Image with Pixels <140 Scaled to Full Range of Brightness
Getting Started with IDL Contrast Enhancement
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Note
Although this command illustrates the use of the IDL minimum and maximum 
operators, the same function can be executed more efficiently by IDL with the 
command:

TV, BYTSCL(MYIMAGE,MIN=140,MAX=200,TOP=!D.TABLE_SIZE)

Figure 6-11: Image Scaled from 140 to 200
Contrast Enhancement Getting Started with IDL



Chapter 6: Images 79

getstart.book  Page 79  Tuesday, June 14, 2005  12:07 PM
Smoothing and Sharpening

Images can be rapidly smoothed to soften edges or compensate for random noise in 
an image using IDL’s SMOOTH function. SMOOTH performs an equally weighted 
smoothing using a square neighborhood of an arbitrary odd width, as shown below.

1. Display myimage smoothed using a 7 by 7 area:

TVSCL,SMOOTH(MYIMAGE,7)

Unsharp Masking

The previous image looks a bit blurry because it contains only the low frequency 
components of the original image. Often, an image needs to be sharpened so that 
edges or high spatial frequency components of the image are enhanced. One way to 
sharpen an image is to subtract a smoothed image containing only low-frequency 
components from the original image. This technique is called unsharp masking.

1. Unsharp mask and display image:

TVSCL, FLOAT(MYIMAGE)-SMOOTH(MYIMAGE,7)

Figure 6-12: Smoothing with SMOOTH
Getting Started with IDL Smoothing and Sharpening
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This command subtracts a smoothed version of the image from the original, scales 
the result, and displays it, as shown previously.

Sharpening Images with Differentiation

IDL has other built-in sharpening functions that use differentiation to sharpen 
images. The ROBERTS function returns the Roberts gradient of an image. Enter the 
following commands:

1. Create a new variable, R, that contains the Roberts gradient of myimage:

R=ROBERTS(MYIMAGE)

2. Display array R:

TVSCL, R

Figure 6-13: Unsharp Masking
Smoothing and Sharpening Getting Started with IDL
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Another commonly used gradient operator is the Sobel operator. IDL’s SOBEL 
function operates over a 3 by 3 region, making it less sensitive to noise than some 
other methods. Enter the following commands.

1. Create a Sobel sharpened version of the image:

SO=SOBEL(MYIMAGE)

2. Display the sharper image:

TVSCL, SO

Figure 6-14: Roberts Gradient of myimage
Getting Started with IDL Smoothing and Sharpening
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Loading Different Color Tables

Try loading some of the pre-defined IDL color tables to make this image more 
visible. While the graphics window is visible, type XLOADCT at the IDL Command 
Line. The XLOADCT widget application appears. Select a color table from the field; 
the window will reflect the color scheme. Click “Done” to accept a color table. When 
you are finished looking at the effects of different tables, click on the first color table 
in the field, B-W Linear, and click “Done” to load the original black and white color 
table.

Note
If you load a new color table while an image is still being displayed on a 24-bit 
(true) color display, you will need to close the image and reload it in IDL in order to 
see the new image displayed in the new color scheme. In an 8-bit (pseudo) color 
display however, you will not need to re-display the image as the color change will 
be immediate.

Figure 6-15: Sobel Sharpened Version of myimage
Smoothing and Sharpening Getting Started with IDL
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Other Image Manipulations

Sections of images can be easily displayed by using subarrays. 

1. Erase the current display, create a new array that contains Manhattan and 
display it by entering:

ERASE
E=MYIMAGE[100:300, 150:250]

2. Then enter:

TV, E

3. Enter WDELETE at the Command Line to dismiss the graphics window.

WDELETE

Rotating an Image

Simple rotation in multiples of 90 degrees can be accomplished with the ROTATE 
function. 

1. Rotate the image by 90 degrees, as shown below, by entering:

R=ROTATE(E,1)

Figure 6-16: Displaying a Section of an Image
Getting Started with IDL Other Image Manipulations
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2. Now enter to display:

TVSCL, R

The second parameter of ROTATE is an integer from 1 to 8 that specifies 
which one of the eight possible combinations of rotation and axis reversal to 
use.

3. Enter WDELETE at the Command Line to dismiss the graphics window for 
the next graphic.

WDELETE

Figure 6-17: The Image Rotated by 90 Degrees
Other Image Manipulations Getting Started with IDL
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Extracting Profiles

Another useful image processing tool is the PROFILES routine. This routine 
interactively draws row or column profiles of an image. It allows you to view an 
image and an X-Y plot of the pixel brightnesses in any row or column of the image 
simultaneously. 

1. Use the PROFILES routine with the rotated image that you just displayed by 
entering the following:

PROFILES, R

A new window for displaying the profiles appears. Move the cursor in the 
window containing the image R to display the profiles of different rows and 
columns. 

2. Click the left mouse button while the cursor is in the image window to switch 
between displaying row and column profiles. 

3. Click the right mouse button while the cursor is in the image window to exit 
the PROFILES routine. 

Figure 6-18: Viewing an Image and an X-Y Plot of the Pixel Brightnesses
Getting Started with IDL Extracting Profiles
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More About Images in IDL

IDL offers much more in the area of Image Processing. To learn more about IDL’s 
image processing capabilities, see Image Processing in IDL. For much more 
information on working with the iImage tool, see Chapter 10, “Working with 
Images” in the iTool User’s Guide manual.
More About Images in IDL Getting Started with IDL
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Chapter 7

Surfaces and Contours
This chapter describes the following topics:
Surfaces and Contours in IDL . . . . . . . . . . .  88
Accessing Binary Surface Data . . . . . . . . . .  89
Using the iSurface Tool . . . . . . . . . . . . . . . .  90
Using the iContour Tool  . . . . . . . . . . . . . . .  92

Surface Data and the Command Line  . . . .  94
Contour Data and the Command Line  . . .  100
Plotting with SHOW3  . . . . . . . . . . . . . . .  105
More About Surfaces and Contours . . . . .  106
Getting Started with IDL 87
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Surfaces and Contours in IDL

IDL provides many command line techniques for visualizing two-dimensional arrays, 
including contour plots, wire-mesh surfaces, and shaded surfaces. The new iSurface 
and iContour tools are also available for easy surface and contour visualization and 
manipulation. This chapter demonstrates just a few of the options for visualizing and 
manipulating data in three dimensions.

Note
To simplify obtaining useful results from the command line examples in this 
manual, create a bitmap buffer for your graphic windows and to use a maximum of 
256 colors by entering the following command at the IDL command prompt:

DEVICE, RETAIN=2, DECOMPOSED=0
Surfaces and Contours in IDL Getting Started with IDL
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Accessing Binary Surface Data

For this example we will use the binary dataset of the Maroon Bells Mountains. We 
will use the BINARY_TEMPLATE and READ_BINARY functions to read this data 
set. Once you have read the file into IDL, you are ready to move on to visualizing the 
data set three-dimensionally.

To import binary data directly into IDL, use the BINARY_TEMPLATE function in 
conjunction with the READ_BINARY function. To import a binary data file into 
IDL, you must first describe the format of the data using the Binary Template. 

The binary file that we will read in the following example is stored as an integer array 
and contains an image of the Maroon Bells mountains, a group of mountains located 
among the Rocky Mountains of Colorado.

1. At the IDL Command Line, enter the following:

MARBELLSTEMPLATE=BINARY_TEMPLATE(FILEPATH('surface.dat', $
SUBDIR = ['examples', 'data']))

The binary template dialog box appears. 

2. In the Template Name field, enter “marbellstemplate” for the name of the new 
template. 

3. In the File’s byte ordering pull-down field, select “Little Endian” since we 
know that this file was created on an Intel processor-based machine. 

4. Click the New Field button in the lower left corner of the dialog box.

5. When the New Field dialog appears, enter “MARBELLS” as the field name. 
Verify the box in the upper right corner marked Returned in the result since 
we will want our data set returned at the time it is read. 

6. At the Number of Dimensions pull-down menu, be sure to specify that we are 
dealing with a two-dimensional data set here. These data are contained in a 350 
by 450 array, so we will enter these values in the two boxes marked Size. 

7. Specifying Integer (16 bits) at the Type pull-down menu. Click OK.

8. Click OK when the binary template dialog reappears.

9. Use the READ_BINARY function to read the template we have just created. 
At the IDL Command Line, enter:

MARBELLS_BINARY=READ_BINARY (FILEPATH('surface.dat', $
SUBDIR=['examples', 'data']),TEMPLATE=MARBELLSTEMPLATE)
Getting Started with IDL Accessing Binary Surface Data
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Using the iSurface Tool

The IDL iSurface tool provides interactive access to surface data. You can visualize 
surfaces and then modify and manipulate those surfaces in a single interactive 
environment.

Displaying a Surface

To import a file containing surface data into the iSurface tool:

1. Follow the steps in “Accessing Binary Surface Data” on page 89 for 
instructions on how to read in the binary marbells.dat file, located in the 
examples\data directory of your IDL installation.

2. After entering all steps to read in your binary template, at the IDL Command 
Line, type: iSurface, MARBELLS_BINARY.MARBELLS. This displays the 
surface data. 

Figure 7-1: Maroon Bells Binary Data Visualized in the iSurface Tool
Using the iSurface Tool Getting Started with IDL
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Modifying Surfaces

The iSurface tool allows you many options for manipulating and modifying surfaces. 
For example, rotation tools are provided in the iSurface tool to make it easier to see 
all aspects of a 3-D surface visualization. Surfaces can be rotated freely or along an 
axis with the mouse, and they can be rotated in fixed or arbitrary increments from the 
Operations menu.

To rotate a surface freely or along an axis with the mouse:

1. Select the surface in the iSurface window.

2. Click Rotate  on the Manipulator toolbar. The rotation sphere is displayed 
around the surface.

• To rotate the surface freely, position the mouse pointer over the surface so 
that it changes to a free rotation pointer . Click and drag to rotate the 
surface in the desired direction.

• To rotate the surface along an axis, position the mouse pointer over an axis 
so that it changes to an axis rotation pointer . Click and drag to rotate 
the surface along the axis in the desired direction.

To rotate a surface in 90° increments left or right from the Operations menu:

1. Select the surface in the iTool window.

2. Select Operations → Rotate → Rotate Left or Operations → Rotate → 
Rotate Right.

To rotate a surface an arbitrary number of degrees from the Operations menu:

1. Select the surface in the iTool window.

2. Select Operations → Rotate → Rotate by Angle.

3. In the Rotate Angle dialog, enter the desired number of degrees to rotate the 
surface.

Other options are available in iSurface such as manipulating surface color, texture 
mapping, and annotating among other things. For much more information on 
working with the iSurface tool, see Chapter 11, “Working with Surfaces” in the iTool 
User’s Guide manual.
Getting Started with IDL Using the iSurface Tool
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Using the iContour Tool

The IDL iContour tool provides interactive access to contour data. You can visualize 
contours and then modify and manipulate those contours in a single interactive 
environment.

Displaying a Contour

To import a file containing binary data into the iContour tool:

1. Follow steps in “Accessing Binary Surface Data” on page 89 for instructions 
on how to read in the binary marbells.dat file.

2. After entering all steps to read in your binary template, at the IDL Command 
Line, type: iContour, MARBELLS_BINARY.MARBELLS

The contour is now displayed in iContour.

Figure 7-2: Maroon Bells Binary Data Visualized in the iContour Tool
Using the iContour Tool Getting Started with IDL
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Modifying a Contour

The iContour tool allows you many options for contour modification and 
manipulation. For example, you can add a legend to your contour which shows the 
levels of the contour in their increments. To add a legend, select Insert → Legend 
from the iContour tool window. Once you have placed a legend on your contour can 
edit the legend settings such as the title and level increments as well as the color 
options on the legend. Double-clicking on the legend itself will show you the 
Visualization Browser. 

There are many other tasks available within iContour such as manipulating contour 
color, values, and annotating among other things. For much more information on 
working with the iContour tool, see Chapter 12, “Working with Contours” in the 
iTool User’s Guide manual.
Getting Started with IDL Using the iContour Tool
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Surface Data and the Command Line

Surface data can be visualized and manipulated at the IDL Command Line. First, we 
need to create a two-dimensional dataset which we will then visualize. See 
“Accessing Binary Surface Data” on page 89 for instructions to open this data set. 

First, view the array MARBELLS_BINARY.MARBELLS as a three-dimensional, 
“wire-mesh” surface. Use the CONGRID procedure initially to resample the data set 
so that the “mesh” can be displayed at a size visible to the human eye. 

1. Here resample the array size to 35 by 45, or one tenth its original size. To do 
this enter:

MARBELLS=CONGRID(MARBELLS_BINARY.MARBELLS,35,45)

2. Now we are ready to visualize the mesh using the SURFACE command:

SURFACE, MARBELLS

Note
You can also enter ISURFACE, MARBELLS and interactively manipulate the 
display. 

Figure 7-3: Surface Plot with Default Angles
Surface Data and the Command Line Getting Started with IDL
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The SURFACE command can be used to view your data from different angles. AX 
and AZ are plotting keywords that are used to control the SURFACE command. The 
keyword AX specifies the angle of rotation of the surface (in degrees towards the 
viewer) about the X axis. The AZ keyword specifies the rotation of the surface in 
degrees counterclockwise around the Z axis.

3. View the array from a different angle by entering the following command:

SURFACE, MARBELLS, AX = 70, AZ = 25

Displaying a Shaded Surface

You can also view a two-dimensional array as a light-source shaded surface. 

1. First, load one of the pre-defined IDL color tables by entering:

LOADCT, 3

2. To view the light-source shaded surface, shown in the following, simply enter 
the command:

SHADE_SURF, MARBELLS

Figure 7-4: Surface Plot Showing Different Angles
Getting Started with IDL Surface Data and the Command Line
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3. To look at the array from another angle, enlarge the label text, and add a title. 
Again, keywords are used to control certain features of the shaded surface plot. 
The AX and AZ keywords control the viewing angle, just as they did with the 
SURFACE command. 

The CHARSIZE keyword controls the size of plotted text. The TITLE 
keyword was used to add the title “Shaded Surface Representation”.

SHADE_SURF,MARBELLS,AX=45,AZ=20,CHARSIZE=1.5, $
TITLE='Shaded Surface Representation'

Figure 7-5: Surface Plot with Light-source Shaded
Surface Data and the Command Line Getting Started with IDL
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4. You can create a different kind of shaded surface, where the shading 
information is provided by the elevation of each point. Now different shading 
colors on the plot correspond to different elevations (the BYTSCL function 
scales the data values into the range of bytes). 

You could also specify a different array for the shading colors.

SHADE_SURF,MARBELLS,SHADE=BYTSCL(MARBELLS)

Figure 7-6: Surface Plot with Annotated Surface Plot
Getting Started with IDL Surface Data and the Command Line
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Figure 7-7: Byte-scaled Surface Plot
Surface Data and the Command Line Getting Started with IDL
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5. You can plot a wire-frame surface of the Maroon Bells Mountains right over 
the existing plot. The XSTYLE, YSTYLE, and ZSTYLE keywords are used to 
select different styles of axis. Here, SURFACE is set to not draw the X, Y, and 
Z axes because they were already drawn by the SHADE_SURF command. 

The /NOERASE keyword allows the SURFACE plot to be drawn over the 
existing SHADE_SURF plot. Enter the following:

SURFACE,MARBELLS,XSTYLE=4,YSTYLE=4,ZSTYLE=4,/NOERASE

Figure 7-8: Byte-scaled Surface Plot with an Overlaid Wire-frame
Getting Started with IDL Surface Data and the Command Line
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Contour Data and the Command Line

Contour data can be visualized and manipulated at the IDL Command Line. First, we 
need to create a two-dimensional dataset which we will then visualize. See 
“Accessing Binary Surface Data” on page 89 for instructions to open this data set. 
Once you have read the file into IDL, you are ready to move on to visualizing the data 
set three-dimensionally

Displaying a Contour

Another way to view a two-dimensional array is as a contour plot. A simple contour 
plot of the Data can be created. 

1. Set the array size back to its original 350 by 450 size by entering:

MARBELLS=MARBELLS_BINARY.MARBELLS

2. Plot the contour:

CONTOUR, MARBELLS

That command was very simple, but the resulting plot was not as informative 
as it could be.

Figure 7-9: Contour Plot
Contour Data and the Command Line Getting Started with IDL
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3. Create a customized CONTOUR plot with more elevations and labels by 
entering:

CONTOUR,MARBELLS,NLEVELS=8,C_LABELS=[0,1]

By using the NLEVELS keyword, CONTOUR was told to plot eight equally-
spaced elevation levels. The C_LABELS keyword specifies which contour 
levels should be labeled. By default, every other contour is labeled. 
C_LABELS allows you to override this default and explicitly specify the 
levels to label.

Figure 7-10: Contour Plot with Elevation Labeled
Getting Started with IDL Contour Data and the Command Line
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4. Similarly, you can create a filled contour plot where each contour level is filled 
with a different color (or shade of gray) by setting the FILL keyword. To do 
this, enter:

CONTOUR,MARBELLS,NLEVELS=8,/FILL

5. To outline the resulting contours, make another call to CONTOUR and set the 
OVERPLOT keyword to keep the previous plot from being erased. 

You can add tickmarks that indicate the slope of the contours (the tickmarks 
point in the downhill direction) by setting the DOWNHILL keyword:

CONTOUR,A,NLEVELS=8,/OVERPLOT,/DOWNHILL

Figure 7-11: Contour Plot with Filled Contour Plot
Contour Data and the Command Line Getting Started with IDL
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6. CONTOUR plots can be rendered from a three-dimensional perspective. 

First, set up the default 3-D viewing angle by entering:

SURFR

7. By using the T3D keyword in the next call to CONTOUR, the contours will be 
drawn as seen from a 3-D perspective. Enter:

CONTOUR,MARBELLS,NLEVELS=8,/T3D

Figure 7-12: Contour Plot with Downhill Tickmarks Labeled
Getting Started with IDL Contour Data and the Command Line
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Figure 7-13: Contour Plot with 3-D Contour Plot 
Contour Data and the Command Line Getting Started with IDL
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Plotting with SHOW3

In addition to IDL’s built-in routines, there are many functions and procedures 
included with IDL that are written in the IDL language and that can be changed, 
customized, or even rewritten by IDL users. The SHOW3 procedure is one of these 
routines. 

1. Create a plot that shows a two-dimensional array as an image, wire-frame 
surface, and contour simultaneously.

SHOW3,MARBELLS

Figure 7-14: Combined Surface and Contour Plots Using SHOW3
Getting Started with IDL Plotting with SHOW3
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More About Surfaces and Contours 

IDL offers much more in the area of working with Surfaces and Contours. To learn 
more about surface and contour functionality in IDL, see Using IDL and For much 
more information on working with the iSurface and iContour tools, see Chapter 11, 
“Working with Surfaces” in the iTool User’s Guide manual and Chapter 12, 
“Working with Contours” in the iTool User’s Guide manual. For more information on 
surface and contour objects, see Chapter 5, “Working with Plots and Graphs” and 
Chapter 6, “Working with Surface Objects” in the Object Programming manual. 
More About Surfaces and Contours Getting Started with IDL
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Chapter 8

Volume Visualization
This chapter describes the following topics:
IDL and Volume Visualization  . . . . . . . . .  108
Using the iVolume Tool . . . . . . . . . . . . . . .  109
Command Line Volume Visualization . . . .  112

Volume Slices and the IDL Slicer  . . . . . .  117
Displaying a Surface with the Slicer  . . . .  119
More About Volume Visualization . . . . . .  121
Getting Started with IDL 107
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IDL and Volume Visualization

IDL can be used to visualize multi-dimensional volume datasets either at the 
command line or using the new iVolume tool. Given a 3-D grid of density 
measurements, IDL can display a shaded surface representation of a constant-density 
surface (also called an iso-surface). For example, in medical imaging applications, a 
series of 2-D images can be created by computed tomography or magnetic resonance 
imaging. When stacked, these images create a grid of density measurements that can 
be contoured to display the surfaces of anatomical structures.

This chapter demonstrates the use of the SHADE_VOLUME and POLYSHADE 
commands for iso-surface visualization at the command line. The chapter then 
concludes with a brief look at the interactive iVolume tool.

Note
To simplify obtaining useful results from the command line examples in this 
manual, create a bitmap buffer for your graphic windows by entering the following 
command at the IDL command prompt:

DEVICE, RETAIN=2, DECOMPOSED=0
IDL and Volume Visualization Getting Started with IDL



Chapter 8: Volume Visualization 109

getstart.book  Page 109  Tuesday, June 14, 2005  12:07 PM
Using the iVolume Tool

The interactive iVolume tool allows you great flexibility in manipulating and 
visualizing true volume data.

Displaying a Volume

Here is a simple example of one way to visualize a volume using the iVolume tool.

1. At the IDL command line, specify the location of the data file:

file = FILEPATH('head.dat', $
SUBDIRECTORY = ['examples', 'data'])

data = READ_BINARY(file, DATA_DIMS = [80, 100, 57])

2. Now invoke the iVolume tool to visualize the volume:

iVolume, data

Volume data does not automatically appear in the tool window since volume 
rendering can be a time consuming operation. To render the volume, click the 
Render button on the tool. Auto-render is available but not set by default since it can 
slow down your iTool session if you have simultaneous operations.

Note
Volume data is only rendered if the volume dataspace is selected. Thus, if you have 
multiple volumes in your dataspace, auto-render must be turned on in order to 
render both simultaneously.

The data loaded earlier can be displayed by clicking the Render button.
Getting Started with IDL Using the iVolume Tool
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Volume Rendering Quality

The volume can be rendered in two quality modes:

• Low — Done with a stack of 2D texture-mapped semi-transparent polygons. 
The polygons are oriented so that the flat sides face the viewer as directly as 
possible. On most systems, Low-quality mode renders faster than High-quality 
mode, but not as accurately.

• High — Done with the IDLgrVolume ray-casting volume renderer. This 
quality mode is CPU-intensive and will usually take much longer than the 
Low-quality mode.

Volume Extents

Since the volume is not always rendered, iVolume draws volume extents to help you 
locate and select the volume. You can select the volume by selecting on the extents, 

Figure 8-1: Rendered MRI Head Volume Data
Using the iVolume Tool Getting Started with IDL
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without rendering the volume. By default, iVolume draws a translucent solid cube 
with internal extents. You can also select a wire frame, or no extents.

Note
Use caution when turning off extents. If extents are turned off and Auto-Render is 
also off, you may need to use the Visualization Browser to select the volume again.

Modifying Volume Data

The iVolume tool allows you many options such as displaying multiple planes, 
manipulating volume color and lighting, filtering, resampling, image planes, 
isosurfaces, interval volumes, viewing statistics and annotating. For much more 
information on working with the iVolume tool, see Chapter 14, “Working with 
Volumes” in the iTool User’s Guide manual.
Getting Started with IDL Using the iVolume Tool
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Command Line Volume Visualization

Visualizing volume data at the IDL command line is as easy as reading in data and 
then calling the correct command to visualize. The following sections will guide you 
through the process of reading and visualizing volume data via the command line.

Reading in a Dataset for Visualization

The following steps illustrate the use of BINARY_TEMPLATE and 
READ_BINARY to read in a dataset:

1. First, create the template for reading the data. At the IDL Command Line, 
enter:

MYTEMPLATE=BINARY_TEMPLATE(FILEPATH('head.dat',$
SUBDIR=['examples', 'data']))

The binary template dialog box appears.

2. In the Template Name field, enter “Head” as the name of the new template. 

3. Now we are ready to enter the field values, click the box in the lower left 
corner of the dialog box called “New Field”.

4. When the New/Modify Field dialog appears, enter “B” as the field name. 
Check the box in the upper right corner marked “Returned” since we will want 
our data set returned at the time it is read. 

At the “Number of Dimensions” pull-down menu, be sure to specify that we 
are dealing with a three-dimensional data set. These data are contained in an 80 
by 100 by 57 array, so we will enter these values in the three boxes marked 
“size”. 

Finally, let the binary template dialog know that we are dealing with Byte type 
data by specifying “Byte (Unsigned 8-bits) at the “Type” pull-down menu.

Once you have entered the above data, the binary template dialog appears once 
again showing the specifications you have made.

5. Click “OK”.

Now we will use the READ_BINARY procedure to read the data defined by 
template we have just created. 

6. At the IDL Command Line, enter:

HEAD_BINARY=READ_BINARY(FILEPATH('head.dat',
$ SUBDIR=['examples','data']),TEMPLATE=MYTEMPLATE)
Command Line Volume Visualization Getting Started with IDL
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3-D Transformations

When creating “3-D” plots at the IDL command line (for example, surfaces, shaded 
surfaces, and volume visualizations), a three-dimensional transformation needs to be 
set up. The 3-D transformation applies the requested translation, rotation, and scaling 
to a 3-D plot before displaying it.

Three-dimensional transformations are especially important when using the 
POLYSHADE routine. Unless the transformation is set up such that the entire 
volume is visible, the volume will not be rendered correctly. Once a 3-D 
transformation has been established, most IDL plotting routines can be made to use it 
by including the T3D keyword. 

There are a number of ways to set up a transformation matrix in IDL.

One way is that a transformation matrix can be entered explicitly into the system 
variable !P.T. This method is rather difficult, because you have to figure out the 
transformation yourself. More information about the transformation matrix can be 
found in “Coordinate Conversions” in Chapter 8 of the Using IDL manual.

Another method, is the SURFACE and SHADE_SURF commands, which 
automatically create a 3-D transformation based on the datasets being visualized.

1. For example, specify a slice of the data:

SLICE=(HEAD_BINARY.B)[*,*,25]

2. Now surface the slice specified:

SURFACE, SLICE
Getting Started with IDL Command Line Volume Visualization
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A number of different IDL procedures that simplify the creation of 3-D 
transformations can be used. Keyword arguments to some of these procedures allow 
you to set viewing angles and data ranges. The procedures then create the appropriate 
transformation matrix for you and store it in !P.T. These procedures include T3D, 
SCALE3, SCALE3D, and SURFR. For more information on these routines, consult 
the IDL Reference Guide.

Visualizing an Iso-Surface

Two IDL commands, SHADE_VOLUME and POLYSHADE, are used together to 
visualize an iso-surface. SHADE_VOLUME generates a list of polygons that define 
a 3-D surface given a volume dataset and a contour (or density) level. The function 
POLYSHADE can then be used to create a shaded-surface representation of the iso-
surface from those polygons.

Like many other IDL commands, POLYSHADE accepts the T3D keyword that 
makes POLYSHADE use a user-defined 3D transformation. Before you can use 
POLYSHADE to render the final image, you need to set up an appropriate three-
dimensional transformation. The XRANGE, YRANGE, and ZRANGE keywords 
accept 2-element vectors, representing the minimum and maximum axis values, as 

Figure 8-2: Using SURFACE to Visualize a Slice of head.dat
Command Line Volume Visualization Getting Started with IDL
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arguments. POLYSHADE returns an image based upon the list of vertices, V, and list 
of polygons, P. The T3D keyword tells POLYSHADE to use the previously-defined 
3D transformation. The TV procedure displays the shaded-surface image. 

Enter the following lines:

1. Create the polygons and vertices that define the iso-surface with a value of 70. 
Return the vertices in V and the polygons in P:

SHADE_VOLUME,HEAD_BINARY.B,70,V,P,/LOW

2. Set appropriate limits for the X, Y, and Z axes with the SCALE3 procedure:

SCALE3,XRANGE=[0,80],YRANGE=[0,100],ZRANGE=[0,57]
Getting Started with IDL Command Line Volume Visualization
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3. Display a shaded-surface representation of the previously generated arrays of 
vertices and polygons:

TV,POLYSHADE(V,P,/T3D)

Figure 8-3: Shaded-surface Representation Using POLYSHADE
Command Line Volume Visualization Getting Started with IDL
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Volume Slices and the IDL Slicer

Another useful volume visualization tool is IDL’s SLICER3 procedure. The Slicer is 
a widget-based application that allows you to create iso-surfaces and pass cutting 
planes through 3-D datasets.

The IDL Slicer provides many other volume visualization techniques. As the name 
implies, the slicer allows you to look at slices through a volume dataset.

1. To use the slicer with dataset B, it is first required to pass in a pointer to the 
data set by entering the following at the IDL Command Line:

BDATA=PTR_NEW(HEAD_BINARY.B)

2. Then enter:

SLICER3,BDATA

3. The IDL Slicer appears. The Slicer window will come up empty by default 
though the data is loaded. Be sure that the Mode pull-down menu is set to Slice 
which is the default. Position the pointer within the cube. Hold down the left 
mouse button and move the mouse. (In IDL for Macintosh, the mouse button is 
interpreted as the left mouse button.) An outline of the cutting plane appears. 
This plane moves only in the direction indicated by the orientation display. 
Move the cutting plane to the center of the volume and release the mouse 
button. A cross-section of the volume is displayed.
Getting Started with IDL Volume Slices and the IDL Slicer
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4. To make slices in different orientations, move the cursor into the large drawing 
window and press the right mouse button. 

5. To simulate a right mouse button press, IDL for Macintosh users can hold 
down the command key and click the mouse. The orientation display changes 
to show the new direction of the cutting plane. 

6. Click the right button a second time to see the third possible orientation. 

7. Make slices in these orientations by clicking on the mouse button and dragging 
the cutting plane outline to the desired location.

Figure 8-4: IDL Slicer3
Volume Slices and the IDL Slicer Getting Started with IDL
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Displaying a Surface with the Slicer

To display a surface with the IDL Slicer, do the following:

1. To create a surface in Slicer similar to the one you created previously at the 
IDL command line, click on the Surface option on the Mode pull-down menu 
on the Slicer. A Surface Threshold window, a slider, and a number of new 
buttons should appear. 

2. Click in the Surface Threshold and slide the determiner line to choose the 
Display button. A status window reports on the number of vertices and 
polygons generated and then the iso-surface appears.

Figure 8-5: IDL Slicer3 with a Surface
Getting Started with IDL Displaying a Surface with the Slicer
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Dismiss the Slicer and Volume Windows

When you are done experimenting with the Slicer, before continuing with other 
chapters in this book, you should dismiss the Slicer window. 

1. To exit the volume window, enter the following at the Command Line:

WDELETE

2. To exit the IDL Slicer, choose the path File → Quit.
Displaying a Surface with the Slicer Getting Started with IDL
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More About Volume Visualization

For a list of volume-related routines, see the “Volume Visualization” section of the 
category “3D Visualization” in  of the IDL Quick Reference manual. To take 
advantage of all of IDL’s powerful capabilities in creating and manipulating 
volumes, see the IVolume tool in Chapter 14, “Working with Volumes” in the iTool 
User’s Guide manual. See Chapter 7, “Creating Volume Objects” in the Object 
Programming manual for information on volume objects. 
Getting Started with IDL More About Volume Visualization
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Chapter 9

Mapping
This chapter describes the following topics:
IDL and Mapping  . . . . . . . . . . . . . . . . . . .  124
Using the iMap Tool  . . . . . . . . . . . . . . . . .  125
Drawing Map Projections  . . . . . . . . . . . . .  126
Drawing an Orthographic Projection . . . . .  129
Plotting a Portion of the Globe  . . . . . . . . .  131

Plotting Data on Maps  . . . . . . . . . . . . . . .  132
Reading Latitudes and Longitudes . . . . . .  134
Plotting Contours Over Maps . . . . . . . . . .  135
Warping Images to Maps  . . . . . . . . . . . . .  137
More About Mapping . . . . . . . . . . . . . . . .  142
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IDL and Mapping

IDL’s mapping facilities allow you to plot data over different projections of the 
globe. This chapter shows how to display various map projections and plot data over 
them.

In this chapter, we will enter statements at the IDL Command Line. This 
demonstrates IDL’s interactive capability, and shows how easy it is to manipulate 
your data.

Note
To simplify obtaining useful results from the examples in this manual, create a 
bitmap buffer for your graphic windows and to use a maximum of 256 colors by 
entering the following command at the IDL command prompt:

DEVICE, RETAIN=2, DECOMPOSED=0
IDL and Mapping Getting Started with IDL
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Using the iMap Tool

The interactive iMap tool allows you great flexibility in manipulating and visualizing 
map data.

Displaying a Map

You can apply a map projection before or after you import image or contour data into 
the iMap tool. To do so, select Operations →  Map Projection. This command 
opens the Map Projection dialog, shown in the following figure:.

You can apply a map projection to another iTool as well. If you do, the tool will adapt 
to expose iMap functionality, including the iMap operations and the Map panel.

Modifying Map Data

The iMap tool allows you many options such as inserting a map grid and inserting 
shapefiles. For much more information on working with the iMap tool, see “Working 
with Maps” in Chapter 15 of the iTool User’s Guide manual.

Figure 9-1: The Map Projection Dialog
Getting Started with IDL Using the iMap Tool
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Drawing Map Projections

Drawing continental outlines and plotting data in different projections is easy using 
IDL’s mapping routines. The MAP_SET routine is the heart of the mapping package. 
It controls the type of projection and the limits of the global region to be mapped.

1. Reset the graphics window to default size:

WINDOW

2. Display a cylindrical projection map of the world:

MAP_SET,/CYLINDRICAL,/GRID,/CONTINENTS,/LABEL

The CYLINDRICAL keyword tells MAP_SET to use the cylindrical 
projection. The GRID keyword causes the latitude and longitude lines to be 
drawn. The LABEL keyword adds the latitude and longitude labels. The 
CONTINENTS keyword tells MAP_SET to draw continental outlines.

A similar map could be created by entering a series of separate commands to 
set up the type of projection, draw the continent outlines, and then draw the 
grid lines.

Figure 9-2: A Cylindrical Projection
Drawing Map Projections Getting Started with IDL
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Although the single-line MAP_SET command is quicker to enter, by using the 
separate MAP_SET, MAP_GRID, and MAP_CONTINENTS commands, you 
exercise more control over the map colors, fills, and so on.

3. Load a new color table.

LOADCT,39

4. Display a Miller cylindrical projection of the world.

MAP_SET,/MILLER

5. Draw the continent outlines. The FILL keyword fills in the continents using 
the color specified by the COLOR keyword.

MAP_CONTINENTS,COLOR=220,/FILL

6. Draw the grid lines. The COLOR keyword specifies the color of the grid lines. 
The LABEL keyword labels the lines. 

MAP_GRID,COLOR=160,/LABEL

The order of MAP_GRID and MAP_CONTINENTS depends on how you 
wish to display your map. In the above example, if you call MAP_GRID 
before MAP_CONTINENTS, the filled continents are drawn over the labeled 
grid lines.

Figure 9-3: Miller Cylindrical Projection with MAP_CONTINENTS and 
MAP_GRID
Getting Started with IDL Drawing Map Projections
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7. Dismiss the graphics window:

WDELETE
Drawing Map Projections Getting Started with IDL
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Drawing an Orthographic Projection

To draw a map that looks more like a globe, use the orthographic projection. 

1. Open a graphics window for viewing:

WINDOW

2. Enter the following at the Command Line:

MAP_SET,30,-100,0,/ORTHOGRAPHIC,/ISOTROPIC,/GRID, $
/CONTINENTS,/LABEL,/HORIZON

Figure 9-4: Orthographic Projection Showing North America at the Center
Getting Started with IDL Drawing an Orthographic Projection
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The numbers following the MAP_SET command (30, -100, and 0) are the 
latitude and longitude to be centered and the angle of rotation for the North 
direction. The ISOTROPIC keyword creates a map that has the same scale in 
the vertical and horizontal directions, so we get a circular map in a rectangular 
window. IDL keywords (but not function and procedure names) can always be 
abbreviated to their minimum unique length. The GRID, COLOR, and LABEL 
keywords work the same as before. The HORIZON keyword draws the line at 
which the horizon exists. Without the HORIZON keyword, MAP_SET only 
draws the grid and the continents.

3. Dismiss the graphics window:

WDELETE
Drawing an Orthographic Projection Getting Started with IDL
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Plotting a Portion of the Globe

You do not always have to plot the entire globe, you can plot a section of the globe by 
using the LIMIT keyword which specifies a region of the globe to plot. 

1. Open a graphics window for viewing:

WINDOW

2. Enter the following at the Command Line:

MAP_SET,32,-100,/AZIM,LIMIT=[10, -130, 55, -70], $
/GRID,/CONT,/LABEL

The azimuthal equidistant projection shows the United States and Mexico. The 
AZIM keyword selects the azimuthal equidistant projection. The keyword 
LIMIT is set equal to a four-element vector containing the minimum latitude, 
minimum longitude, maximum latitude, and maximum longitude.

3. Dismiss the graphics window:

WDELETE

Figure 9-5: Azimuthal Equidistant Projection
Getting Started with IDL Plotting a Portion of the Globe
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Plotting Data on Maps

You can annotate plots easily in IDL. To plot the location of selected cities in North 
America, as shown in the following figure, you need to create three arrays: one to 
hold latitudes, one to hold longitudes, and one to hold the names of the cities being 
plotted.

1. Open a graphics window for viewing:

WINDOW

2. Create a 5-element array of floating-point values representing latitudes in 
degrees North of zero.

LATS=[40.02,34.00,38.55,48.25,17.29]

3. The values in LONS are negative because they represent degrees West of zero 
longitude.

LONS=[-105.16,-119.40,-77.00,-114.21,-88.10]

4. Create a five-element array of string values. Text strings can be enclosed in 
either single quotes ('text') or double quotes ("text").

CITIES=['Boulder, CO','Santa Cruz, CA',$
'Washington, DC','Whitefish, MT','Belize, Belize']

5. Draw a Mercator projection featuring the United States and Mexico.

MAP_SET,/MERCATOR,/GRID,/CONTINENT,LIMIT=[10,-130,60,-70]

6. Place a plotting symbol at the location of each city. 

PLOTS,LONS,LATS,PSYM=4,SYMSIZE=1.4,COLOR=220
Plotting Data on Maps Getting Started with IDL
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7. Place the names of the cities near their respective symbols.

XYOUTS,LONS,LATS,CITIES,COLOR=80, $
CHARTHICK=2,CHARSIZE=1.25,ALIGN=0.5

The PSYM keyword makes PLOTS use diamond-shaped plotting symbols instead of 
connecting lines. The SYMSIZE keyword controls the size of the plotting symbols. 
XYOUTS draws the characters for each element of the array CITIES at the 
corresponding location specified by the array elements of LONS and LATS. The 
CHARTHICK keyword controls the thickness of the text characters and the 
CHARSIZE keyword controls their size (1.0 is the default size). Setting the ALIGN 
keyword to 0.5 centers the city names over their corresponding data points.

Figure 9-6: Annotating a Map Projection
Getting Started with IDL Plotting Data on Maps
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Reading Latitudes and Longitudes

If a map projection is displayed, IDL can return the position of the cursor over the 
map in latitude and longitude coordinates. 

1. Enter the command:

CURSOR, LON, LAT & PRINT, LAT, LON

The CURSOR command reads the “X” and “Y” positions of the cursor when the 
mouse button is pressed and returns those values in the LON and LAT variables. Use 
the mouse to move the cursor over the map window and click on any point. The 
latitude and longitude of that point on the map are printed in the Output Log.

2. When you are finished with your map, dismiss the graphics window:

WDELETE
Reading Latitudes and Longitudes Getting Started with IDL
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Plotting Contours Over Maps

Contour plots can easily be drawn over map projections by using the OVERPLOT 
keyword to the CONTOUR routine. See the map in the figure below. Enter the 
following at the Command Line:

1. Open a graphics window for viewing:

WINDOW

2. Create a dataset to plot:

A=DIST(91)

3. Create an X value vector containing 91 values that range from -90 to 90 in 2 
degree increments:

LAT=FINDGEN(91)*2-90

4. Create a Y value vector containing 91 values that range from -180 to 180 in 4 
degree increments:

LON=FINDGEN(91)*4-180

5. Create a new sinusoidal map projection over which to plot the data:

MAP_SET,/GRID,/CONTINENTS,/SINUSOIDAL,/HORIZON

6. Draw a twelve-level contour plot of array A over the map:

CONTOUR,A,LON,LAT,/OVERPLOT,NLEVELS=12
Getting Started with IDL Plotting Contours Over Maps
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Since latitudes range from -90 to 90 degrees and longitudes range from -180 to 180 
degrees, you created two vectors containing the “X” and “Y” values for CONTOUR 
to use in displaying the array A. If the X and Y values are not explicitly specified, 
CONTOUR will plot the array A over only a small portion of the globe.

7. When you are finished with the map, dismiss the graphics window:

WDELETE

Figure 9-7: Plotting Contours Over Maps
Plotting Contours Over Maps Getting Started with IDL
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Warping Images to Maps

Image data can also be displayed on maps. The MAP_IMAGE function returns a 
warped version of an original image that can be displayed over a map projection. In 
this example, elevation data for the entire globe is displayed as an image with 
continent outlines and grid lines overlaid.

1. Define the template for the file worldelv.dat. This file contains a 360 by 360 
square array of byte values.

WORLDTEMPLATE=BINARY_TEMPLATE(FILEPATH('worldelv.dat', $
SUBDIR=['examples', 'data']))

2. When the binary template dialog box appears, name the template 
“WORLDTEMPLATE” and then click New Field. 

3. In the New Field dialog, enter “W” for the Field Name, be sure to specify that 
you have two dimensions and that the field sizes are 360 and 360. 

4. Also select Byte (unsigned) in the Type field. Now click OK in the New 
Field dialog. Click “OK” to close the binary template dialog as well. Next, 
read the file by entering:

WORLDELV_BINARY=READ_BINARY(FILEPATH('worldelv.dat', $
SUBDIR=['examples', 'data']),TEMPLATE=WORLDTEMPLATE)

5. Load a color table.

loadct, 26

6. View the data as an image.

TV, WORLDELV_BINARY.W
Getting Started with IDL Warping Images to Maps
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The first column of data in this image corresponds to 0 degrees longitude. 
Because MAP_IMAGE assumes that the first column of the image being 
warped corresponds to -180 degrees, we’ll use the SHIFT function on the 
dataset before proceeding. 

7. Shift the array 180 elements in the row direction and 0 elements in the column 
direction to make -180 degrees the first column in the array.

WORLDELV_BINARY.W=SHIFT(WORLDELV_BINARY.W, 180, 0)

8. View the data as an image.

TV, WORLDELV_BINARY.W

Figure 9-8: worldelv.dat Visualized with TV
Warping Images to Maps Getting Started with IDL
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From the image contained in the data, we can create a warped image to fit any 
of the available map projections. A map projection must be defined before 
using MAP_IMAGE, because MAP_IMAGE uses the currently defined map 
parameters.

9. Create a Mollweide projection with continents and gridlines.

MAP_SET,/MOLLWEIDE,/CONT,/GRID,COLOR=100

10. Warp the image using bilinear interpolation and save the result in the variable 
new.

NEW=MAP_IMAGE(WORLDELV_BINARY.W,SX,SY,/BILIN)

The SX and SY in the command above are output variables that contain the X 
and Y position at which the image should be displayed. Setting the BILIN 
keyword causes bilinear interpolation to be used, resulting in a smoother 
warped image.

11. Display the new image over the map:

TV,NEW,SX,SY

Figure 9-9: Shifting the Array
Getting Started with IDL Warping Images to Maps
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The SX and SY variables provide TV with the proper starting coordinates for 
the warped image. TV usually displays images starting at position (0, 0). See 
the map in the previous figure. Note that the warped image gets displayed over 
the existing continent and grid lines. 

12. The continent outlines and thick grid lines can be displayed, as shown next, by 
entering:

MAP_CONTINENTS
MAP_GRID,GLINETHICK=3

Figure 9-10: Warping an Image to a Map
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Figure 9-11: Showing gridlines and continents
Getting Started with IDL Warping Images to Maps
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More About Mapping

More information on the IDL mapping routines can be found in Using IDL and in the 
IDL Reference Guide. Also see “Working with Maps” in Chapter 15 of the iTool 
User’s Guide manual.
More About Mapping Getting Started with IDL
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Chapter 10

Plotting Irregularly-
Gridded Data
This chapter describes the following topics:
Irregularly Gridded Data in IDL  . . . . . . . .  144
Creating a Dataset  . . . . . . . . . . . . . . . . . . .  145
The TRIANGULATE Procedure . . . . . . . .  147

Plotting the Results with TRIGRID . . . . .  149
More About Gridding . . . . . . . . . . . . . . . .  151
Getting Started with IDL 143
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Irregularly Gridded Data in IDL

IDL can be used to display and analyze irregularly gridded data. IDL routines allow 
you to easily fit irregularly sampled data to a regular grid. This regularly gridded data 
can then be sent to IDL’s plotting routines. In this chapter, we will see how easy it is 
to manipulate your irregularly gridded data.

Note
To simplify obtaining useful results from the examples in this manual, create a 
bitmap buffer for your graphic windows and to use a maximum of 256 colors by 
entering the following command at the IDL command prompt:

DEVICE, RETAIN=2, DECOMPOSED=0
Irregularly Gridded Data in IDL Getting Started with IDL
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Creating a Dataset

Create a set of 32 irregularly-gridded data points in 3-D space that we can use as 
arguments to the TRIGRID and TRIANGULATE functions.

1. Open a window for viewing:

WINDOW

2. Set SEED to the longword value 1. SEED is used to generate random points.

SEED=1L

3. Set the number of points to be randomly generated.

N=32

4. Create a set of X values for each of the 32 data points.

X=RANDOMU(SEED,N)

5. Create a set of Y values for each of the 32 data points.

Y=RANDOMU(SEED,N)

6. Create a set of Z values for each of the 32 data points from the X and Y values.

Z=EXP(-3*((X-0.5)^2+(Y-0.5)^2))
Getting Started with IDL Creating a Dataset
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7. Plot the XY positions of the random points.

PLOT,X,Y,PSYM=1,TITLE='Random XY Points'

8. Dismiss the graphics window:

WDELETE

Figure 10-1: Plot of random values
Creating a Dataset Getting Started with IDL
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The TRIANGULATE Procedure

The TRIANGULATE procedure constructs a Delaunay triangulation of a planar set 
of points. After a triangulation has been found for a set of irregularly-gridded data 
points, the TRIGRID function can be used to interpolate surface values to a regular 
grid.

1. Open a window for viewing:

WINDOW

2. To return a triangulation in the variable TR, enter the command:

TRIANGULATE,X,Y,TR

The variable TR now contains a three-element by 54-element longword array 
(you may see this by typing “Help, TR” at the IDL Command Line). 

Note
This is not always a 54-element array, it may vary based on the number of points.

3. To produce a plot of the triangulation, shown below, enter the following 
commands:

PLOT,X,Y,PSYM=1,TITLE='Triangulation'

FOR i=0,N_ELEMENTS(TR)/3 - 1 DO BEGIN & T= $
[TR[*, i],TR[0, i]] & PLOTS,X[T],Y[T] & ENDFOR
Getting Started with IDL The TRIANGULATE Procedure
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4. Dismiss the graphics window

WDELETE

Figure 10-2: The triangulation of the random values
The TRIANGULATE Procedure Getting Started with IDL
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Plotting the Results with TRIGRID

Now that we have the triangulation TR, the TRIGRID function can be used to return a 
regular grid of interpolated Z values.

1. Display a surface plot of the gridded data by passing the result of the TRIGRID 
function to SURFACE, using the default interpolation technique and add a title 
to the plot, shown below, by entering:

SURFACE,TRIGRID(X,Y,Z,TR)
XYOUTS,.5,.9,'Linear Interpolation',ALIGN=.5,/NORMAL

The TRIGRID function can also return a smoothed interpolation. Set the 
QUINTIC keyword to use a quintic polynomial method when interpolating the 
grid. 

Figure 10-3: Linear interpolation of triangulated data
Getting Started with IDL Plotting the Results with TRIGRID
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2. Display the results of the quintic gridding method, shown below, by entering:

SURFACE,TRIGRID(X,Y,Z,TR,/QUINTIC XYOUTS, .5,.9,’Quintic 
Interpolation',ALIGN=.5,/NORMAL

Figure 10-4: Quintic interpolation of triangulated data
Plotting the Results with TRIGRID Getting Started with IDL
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More About Gridding

More information on the TRIGRID and TRIANGULATE routines as well as other 
triangulation routines, can be found in the IDL Reference Guide.
Getting Started with IDL More About Gridding
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Chapter 11

Animation
This chapter describes the following topics:
IDL and Animation  . . . . . . . . . . . . . . . . . .  154
Animating a Series of Images  . . . . . . . . . .  155
Displaying an Animation as a Wire Mesh .  157

Animation with XINTERANIMATE . . . .  160
More About Animation  . . . . . . . . . . . . . .  162
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IDL and Animation

IDL can help you visualize your data dynamically by using animation. An animation 
is just a series of still frames shown sequentially. In IDL, a series of frames can be 
represented by a 3-D array (for example, a 3-D array could hold forty, 300 pixel by 
300 pixel images). This chapter shows you how to create an array of images and play 
them back as an animated sequence.

Note
To simplify obtaining useful results from the examples in this manual, create a 
bitmap buffer for your graphic windows and to use a maximum of 256 colors by 
entering the following command at the IDL command prompt:

DEVICE, RETAIN=2, DECOMPOSED=0
IDL and Animation Getting Started with IDL
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Animating a Series of Images

To create an animation that shows a series of images that represent an abnormal 
heartbeat, first read in the images to be displayed. The file holds 16 images of a 
human heart as 64 by 64 element arrays of bytes. 

1. Enter the following commands at the IDL Command Line:

HEARTTEMPLATE=BINARY_TEMPLATE(FILEPATH('abnorm.dat',$
SUBDIR=['examples', 'data']))

2. When the binary template dialog box appears, name the template “Animation” 
and then click New Field. 

3. Enter “H” for the Field Name, be sure to specify that you have three 
dimensions and that the sizes are 64, 64 and 16. 

4. Also select Byte in the Type field. Now click OK for both open dialogs.

5. Next, read the images into variable HEART_BINARY:

HEART_BINARY=READ_BINARY(FILEPATH('abnorm.dat',SUBDIR= $
['examples', 'data']), TEMPLATE=HEARTTEMPLATE)

6. Load an appropriate color table:

LOADCT, 3

7. Display the first “slice” of our 3-D array:

TV,HEART_BINARY.H[*, *, 0]

The asterisks (*) in the first two element positions tell IDL to use all of the 
elements in those positions. Hence, the TV procedure displays a 64 by 64 byte 
image. The image is rather small.

8. Now resize each image in the array with bilinear interpolation by entering:

H=REBIN(HEART_BINARY.H,320,320,16)

9. Then display:

TV,H[*, *, 0]

Each image in H is 5 times its previous size.

Now a simple FOR statement can be used to “animate” the images. (A more 
robust and convenient animation routine, XINTERANIMATE, is described 
next.) 

10. To animate, enter:

FOR I=0,15 DO TVSCL,H[*,*,i]
Getting Started with IDL Animating a Series of Images
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IDL displays the 16 images in the array H sequentially. To repeat the animation, 
press the “up arrow” key to recall the command and press enter.

Note
If the IDLDE screen covers and existing IDL window, you may want to delete the 
current IDL window before recalling the FOR statement in order to clearly see the 
animation.

11. Dismiss the window:

WDELETE

Figure 11-1: Representation of an abnormal heartbeat
Animating a Series of Images Getting Started with IDL
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Displaying an Animation as a Wire Mesh

The same series of images can be displayed as different types of animations. For 
example, each frame of the animation could be displayed as a SURFACE plot.

1. Create a new array to hold the heartbeat data:

S=REBIN(HEART_BINARY.H,32,32,16)

S now holds 32 byte by 32 byte versions of the heartbeat images. SURFACE 
plots are often more legible when made from a resized version of the dataset 
with fewer data points in it. 

2. Display the first image in S, as a wire-mesh surface by entering:

SURFACE,S[*,*,0]

Now create a whole series of SURFACE plots, one for each image in the 
original dataset. 

3. To do this, first create a three-dimensional array to hold all of the images by 
entering:

FRAMES=BYTARR(300,300,16)

The variable frames will hold sixteen, 300 by 300 byte images. 

Figure 11-2: Surface visualization of heartbeat data
Getting Started with IDL Displaying an Animation as a Wire Mesh
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4. Now create a 300 by 300 pixel window in which to display the images:

WINDOW,1,TITLE='IDL Animation',xsize=300,ysize=300

A blank IDL Animation screen will appear.

The next command will draw each frame of the animation. A SURFACE plot 
is drawn in the window and then the TVRD function is used to read the image 
from the plotting window into the frames array. The FOR loop is used to 
increment the array indices. The lines which follow are actually a single IDL 
command. The dollar sign ($) works as a continuation character in IDL and the 
ampersand (&) allows multiple commands in the same line.

5. Enter:

FOR I=0,15 DO BEGIN SURFACE,S[*,*,i],ZRANGE=[0,250]$
& FRAMES[0,0,i]=TVRD()&END

You should see a series of SURFACE plots being drawn in the animation 
window, as shown in below. The ZRANGE keyword is used to keep the 
“height” axis the same for each plot. 

6. Now display the new images in series by entering:

FOR I=0,15 DO TV,FRAMES[*,*,i]

Figure 11-3: One of the SURFACE plots of the animation window
Displaying an Animation as a Wire Mesh Getting Started with IDL
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Note
Once again, if the IDLDE screen covers and existing IDL window, you may want to 
delete the current IDL window before recalling the FOR statement in order to clearly 
see the animation.
Getting Started with IDL Displaying an Animation as a Wire Mesh



160 Chapter 11: Animation

getstart.book  Page 160  Tuesday, June 14, 2005  12:07 PM
Animation with XINTERANIMATE

IDL includes a powerful, widget-based animation tool called XINTERANIMATE. 
Sometimes it is useful to view a single wire-mesh surface or shaded surface from a 
number of different angles. Let’s make a SURFACE plot from one of the S dataset 
frames and view it rotating through 360 degrees. by entering:

1. Save the first frame of the S dataset in the variable A to simplify the next set of 
commands:

A=S[*,*,0]

2. Create a window in which to display your surface:

WINDOW,0,XSIZE=300,YSIZE=300

3. Display A as a wire-mesh surface:

SURFACE,A,XSTYLE=4,YSTYLE=4,ZSTYLE=4

Setting the XSTYLE, YSTYLE, and ZSTYLE keywords equal to 4 turns axis 
drawing off. Usually, IDL automatically scales the axes of plots to best display 
all of the data points sent to the plotting routine. However, for this sequence of 
images, it is best if each SURFACE plot is drawn with the same size axes. The 
SCALE3 procedure can be used to control various aspects of the three-
dimensional transformation used to display plots.

4. Force the X and Y axis ranges to run from 0 to 32 and the Z axis range to run 
from 0 to 250:

SCALE3,XRANGE=[0,31],YRANGE=[0,31],ZRANGE=[0,250]

5. Set up the XINTERANIMATE routine to hold 40, 300 by 300 byte images:

XINTERANIMATE,SET=[300,300,40],/SHOWLOAD

6. Return focus to the plot window for the SURFACE calls which follow.

WSET, 0

7. Generate each frame of the animation and store it for the XINTERANIMATE 
routine. Once a 3-D transformation has been established, most IDL plotting 
routines can be made to use it by including the T3D keyword. The 
[XYZ]STYLE keywords are shortened to [XYZ]ST:

FOR I=0,39 DO BEGIN SCALE3,AZ= -i * 9 & SURFACE,A, $
/T3D,XSTYLE=4,YSTYLE=4,ZSTYLE=4 & XINTERANIMATE,$ 
FRAME=I,WIN=0 & END
Animation with XINTERANIMATE Getting Started with IDL
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8. Play images back as an animation after all the images have been saved in the 
XINTERANIMATE routine:

XINTERANIMATE

The XINTERANIMATE window should appear, as shown above. “Tape recorder” 
style controls can be used to play the animation forward, play it backward, or stop. 
Individual frames can also be selected by moving the “Animation Frame” slider. The 
“Options” menu controls the style and direction of image playback. Click on “End 
Animation” when you are ready to return to the IDL Command Line.

Cleaning Up the Animation Windows

Before continuing with the rest of the tutorials, delete the two windows you used to 
create the animations. The WDELETE procedure is used to delete IDL windows. 

1. Delete both window 0 and window 1 by entering:

WDELETE, 0
WDELETE, 1

Figure 11-4: The XINTERANIMATE window
Getting Started with IDL Animation with XINTERANIMATE
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More About Animation

With just a few IDL commands, you’ve created a number of different types of 
animation. For a list of other animation related commands, see “Animation” in the 
IDL Quick Reference manual.
More About Animation Getting Started with IDL
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Chapter 12

Programming in IDL
This chapter describes the following topics:
IDL and Programming . . . . . . . . . . . . . . . .  164
Programming Capabilities of the IDLDE  .  165
Executing a Simple IDL Program . . . . . . .  168

Debugging Tools in IDL . . . . . . . . . . . . . .  170
Using IDL Projects . . . . . . . . . . . . . . . . . .  172
More About IDL Programming  . . . . . . . .  174
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IDL and Programming

IDL encompasses a complete set of program control statements that allow for the 
writing of sophisticated programs and applications. These control statements are 
similar to, if not identical to, those found in other major programming languages. 
This chapter demonstrates some of IDL’s more basic yet important programming 
capabilities.

Note
For optimum performance when using these examples, create a bitmap buffer for 
your graphic windows and use a maximum of 256 colors by entering the following 
command at the IDL command prompt:

DEVICE, RETAIN=2, DECOMPOSED=0

Note
See Chapter 6, “Library Authoring” in the Building IDL Applications manual for 
information on naming procedures to avoid conflicts with IDL routine names. It is 
important to implement and consistently use a naming scheme from the earliest 
stages of code development to avoid namespace conflicts. 
IDL and Programming Getting Started with IDL
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Programming Capabilities of the IDLDE

The IDL Development Editor (IDLDE) offers you the ability to program applications 
with ease. The term “IDL Application” is used very broadly and any program written 
in the IDL language is treated as an IDL application. IDL applications range from the 
very simple (for example, a MAIN program entered at the IDL command line) to the 
very complex (for example, large programs with graphical user interfaces). Whether 
you are writing a small program to analyze a single data set or a large-scale 
application for commercial distribution, it is useful to understand the programming 
concepts used by the IDL language. IDL even allows you to call IDL from other 
programs written in other languages and call other programs from IDL.

Built-In Editor

The IDL Editor is a programmer-style editor. For example, some characteristics 
include: 

• Indenting a line using the Tab key also allows following lines to be indented

• Using the Shift-Tab key moves position left one tab stop

• Moving the cursor position within an IDL Editor window can be done with the 
mouse or the keyboard

A thorough listing of IDL Editor window key definitions is given in “Editor Window 
Keyboard Shortcuts” in Chapter 2 of the Building IDL Applications manual.

Chromacoded Editor

The Windows IDL Editor supports chromacoding — the automatic coloring of 
different types of IDL statements. Select File → Preference and choose the Editor 
tab to display the colors used for different types of entries recognized by IDL.

Types of IDL Programs

There are multiple ways of executing a program within IDL. These involve varying 
levels of complexity and include:

$Main$

A main program unit consists of a sequence of IDL statements that end in an END 
statement. Only one main program unit may exist within an IDL project window at 
any time. All commands (except executive statements) that can be entered at the IDL 
Command Line can also be contained in an IDL program.
Getting Started with IDL Programming Capabilities of the IDLDE
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Procedure

A procedure is a self-contained sequence of IDL statements that performs a well-
defined task. A procedure is identified by a procedure definition statement where the 
procedure name is the name of the IDL statement you are creating and the parameters 
are named variables that are used in the procedure.

Function

A function is a self-contained sequence of IDL statements that performs a well-
defined task and returns a value to the calling program unit when it is executed. All 
functions return a function value which is given as a parameter in the RETURN 
statement used to exit the function.

See “Overview of IDL Program Types” in Chapter 2 of the Building IDL 
Applications manual for more information.

Compound Statements

The compound statements in IDL are: 

• BEGIN...END — Creates a block of statements

Conditional Statements

The conditional statements in IDL are: 

• IF ... THEN ... ELSE — Conditionally executes a statement or a block of 
statements

• CASE — Selects one, and only one, statement for execution

• SWITCH — Selects one statement for execution from multiple choices

Loop Statements

The loop statements in IDL are: 

• FOR...DO — Executes one or more statements repeatedly, while 
incrementing or decrementing a variable with each repetition, until a condition 
is met

• REPEAT...UNTIL — Repetitively executes a subject statement until a 
condition is true
Programming Capabilities of the IDLDE Getting Started with IDL
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• WHILE...DO — Executes a statement repeatedly while a condition remains 
true

Jump Statements

The jump statements in IDL are: 

• BREAK — Provides a convenient way to immediately exit from a loop 
statement without resorting to the GOTO statement

• CONTINUE — Provides a convenient way to immediately start the next 
iteration of the enclosing FOR, WHILE, or REPEAT loop

• GOTO — Transfers program control to a point in the program specified by the 
label

Note
For more detailed information about the functions of these IDL statements, see 
Chapter 7, “Program Control” in the Building IDL Applications manual.
Getting Started with IDL Programming Capabilities of the IDLDE
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Executing a Simple IDL Program

To show IDL’s programming capabilities, the following program removes the 
bridges from the image of Manhattan Island in New York City using IDL’s erosion 
and dilation capabilities.

1. From the IDLDE, open a new IDL Editor window by selecting File → New → 
Editor (or for Macintosh, simply File → New).

2. Type (or copy) the following lines of code into the new Editor window to form 
a program:

PRO remove_bridges
;
;Read an image of New York.
xsize = 768 ; pixels.
ysize = 512 ; pixels.
img = read_binary( $
    filepath('nyny.dat', subdir=['examples', 'data']), $
    data_dims=[xsize, ysize])
;
;Increase image's contrast.
img = bytscl(img)
;
;Create an image mask from thresholded image.
threshold_level = 70 ; determined empirically.
mask = img lt threshold_level
;
;Make a disk-shaped "structuring element."
disk_size = 7 ; determined empirically.
se = shift(dist(disk_size), disk_size / 2, disk_size / 2)
se = se le disk_size / 2
;
;Remove details in the mask's shape.
mask = dilate(erode(mask, se), se)
;
;Fuse gaps in the mask's shape.
mask = erode(dilate(mask, se), se)
;
;Remove all but the largest region in the mask.
label_img = label_region(mask)
labels = label_img[where(label_img ne 0)] ; Remove 
background.
label = where(histogram(label_img) eq max(histogram(labels)))
mask = label_img eq label[0]
;
;Generate a new image consisting of local area minimums.
new_img = dilate(erode(img, se, /gray), se, /gray)
Executing a Simple IDL Program Getting Started with IDL
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;
;Replace new image with original image, where not masked.
new_img[where(mask eq 0)] = img[where(mask eq 0)]
;
;View result, comparing the new image with the original.
print, 'Hit any key to end program.' 
window, xsize=xsize, ysize=ysize
flick, img, new_img
wdelete
END

Note
Semicolons (;) in IDL code are indicators of the beginning of comment lines, which 
explain what the actual code lines are doing and/or to help you understand your 
code (while being ignored by IDL itself).

Note
The dollar sign ($) at the end of the first line is the IDL continuation character. It 
allows you to enter long IDL commands as multiple lines.

Note
To change the colors used in the chromacoded editor, select File → Preferences 
and then select the Editor tab.

Saving, Compiling and Running

To view the program at work, IDL requires a few additional steps:

1. Save the file as remove_bridges.pro by selecting File → Save As and then 
entering “remove_bridges.pro”.

2. Compile the program by selecting Run → Compile remove_bridges.pro (or 
on Macintosh, simply Run → Compile).

3. Run the program by selecting Run → Run remove_bridges.pro (or for 
Macintosh, simply Run → Run).

Note
If your program encounters an error in running be sure to check your code for 
typographical errors.
Getting Started with IDL Executing a Simple IDL Program
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Debugging Tools in IDL

IDL provides many features to help you debug your program. These features are 
introduced in the following sections. See Chapter 8, “Debugging and 
Error-Handling” in the Building IDL Applications manual for more information.

Breakpoints

Setting breakpoints in your program allows you to stop and step through the 
execution of the program. You can observe the value of variables at those points and 
continue execution of the program.

Variable Watch Window

The Variable Watch Window displays current variable values after IDL has 
completed execution of your program. If the calling context changes during 
execution — such as when stepping into a procedure or function — the variable table 
is replaced with a table appropriate to the new context.

While IDL is at the main program level, the Variable Watch Window remains active 
and displays any variables created.

Figure 12-1: A Complex Breakpoint Dialog

Figure 12-2: The Variable Watch Window
Debugging Tools in IDL Getting Started with IDL
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The IDL Code Profiler

The Code Profiler helps you analyze the performance of your applications. You can 
easily use it to monitor the calling frequency and execution time for procedures and 
functions. The Profiler can be used with programs entered from the command line as 
well as programs run from within a file.

Figure 12-3: The Profile Dialog
Getting Started with IDL Debugging Tools in IDL
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Using IDL Projects

IDL’s project capabilities allow you to easily develop applications. You can manage, 
compile, run, and create distributions of all the files you will need to develop your 
application. All of your application files can be organized so that they are more easily 
accessed and imported to other developers, colleagues, or users.

Note
See Chapter 22, “Creating IDL Projects” in the Building IDL Applications manual 
for details and examples of using IDL project. 

Accessing All Application Files

IDL projects have an easy to use interface that allows you to group:

• IDL source code files (.pro)

Figure 12-4: IDL Projects Window for Macintosh (upper right) 
and Windows (upper left)
Using IDL Projects Getting Started with IDL
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• GUI files (.prc) created with the IDL GUIBuilder

• Data files (ASCII text or binary)

• Image files (.tif, .jpg, .bmp, etc.)

• Other files (help files, .sav files, etc.)

After adding files to a project, you can simply double click on .pro files to open 
them in the IDL editor or .prc files to open them in the IDL GUIBuilder.

Working with Project Files

IDL projects makes it easy to add, remove, move, edit, compile, and test files in your 
project. All of your workspace information is saved as well. If you save and exit your 
project with open files, when again opening the project, those files will be opened 
automatically. IDL projects also store breakpoint information. There is no need to 
reset breakpoints every time you open the project.

Compiling and Running Applications

Compiling and running applications is fast and easy. You can compile all of your 
source files or just the files that you have modified and then run your application 
through the Projects menu. You can customize how your application is compiled and 
run by specifying options for your project.

Building Distributions

Once you have completed your application, you can quickly and easily create a 
distribution. If you have purchased the IDL Developer’s Kit, your application is 
automatically licensed for distribution.

Exporting Applications

You can easily move your application to another platform or distribute your source 
code to colleagues by exporting your project. All your source code, GUI files, data 
files, and image files are copied to a directory you specify. You also have the option 
of creating an IDL Run Time distribution with your application.
Getting Started with IDL Using IDL Projects



174 Chapter 12: Programming in IDL

getstart.book  Page 174  Tuesday, June 14, 2005  12:07 PM
More About IDL Programming

This chapter has given you a very brief introduction and overview into programming 
in IDL. Many more resources are available to you if you wish to continue to learn to 
program in IDL. A wealth of information exists in the Building IDL Applications 
manual. Also see the documentation for specific routines in the IDL Reference Guide.
More About IDL Programming Getting Started with IDL
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Chapter 13

Manipulating Data
This chapter describes the following topics:
IDL and Manipulating Data . . . . . . . . . . . .  176
IDL Array Routines . . . . . . . . . . . . . . . . . .  177

Avoiding IF Statements for Performance .  178
More About Manipulating Data . . . . . . . .  181
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IDL and Manipulating Data

IDL has been specifically designed to process arrays easily and naturally. You can 
get excellent performance in your applications by using the built-in array processing 
routines instead of other methods like FOR loops. This chapter will show how easy it 
is to manipulate your data using IDL’s capabilities.
IDL and Manipulating Data Getting Started with IDL
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IDL Array Routines

IDL contains many array processing procedures and functions dealing with array 
creation, array manipulation, and array and image processing. For a list of array relate 
routines, see Array Creation and “Array Manipulation” in the IDL Quick Reference 
manual. See Chapter 15, “Arrays” in the Building IDL Applications manual for 
details on working with arrays. 
Getting Started with IDL IDL Array Routines
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Avoiding IF Statements for Performance

Programs with array expressions run faster than programs with scalars, loops, and IF 
statements. The following sections provide alternatives to using IF statements.

Summing to Avoid IF Statements

The first example adds all positive elements of array B to array A.

• Using a loop will be slow:

FOR I=0,(N-1)DO IF B[I]GT 0 THEN A[I]=A[I] + B[I]

• Fast way: Mask out negative elements using array operations.

A=A + (B GT 0) * B

• Faster way: Add B > 0

A=A + (B > 0)

When an IF statement appears in the middle of a loop with each element of an 
array in the conditional, the loop can often be eliminated by using logical array 
expressions.

Using Array Operators and the WHERE Function

In the example below, each element of C is set to the square-root of A if A[I] is 
positive; otherwise, C[I] is set to minus the square-root of the absolute value of A[I].

• Using an IF statement is slow:

FOR I=0,(N-1) DO IF A[I] LE 0 THEN C[I]=-SQRT(-A[I]) ELSE 
C[I]=SQRT(A[I])

• Fast way:

C = ((A GT 0) * 2 - 1 ) * SQRT(ABS(A))

The expression (A GT 0) has the value 1 if A[I] is positive and has the value 
0 if A[I] is not. (A GT 0)* 2 - 1 is equal to +1 if A[I] is positive or -1 if 
A[I] is negative, accomplishing the desired result without resorting to loops or 
IF statements.

Another method is to use the WHERE function to determine the subscripts of the 
negative elements of A and negate the corresponding elements of the result.

• Get subscripts of negative elements.

NEGS=WHERE(A LT 0)
Avoiding IF Statements for Performance Getting Started with IDL
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• Take root of absolute value.

C = SQRT(ABS(A))

• Negate elements in C corresponding to negative elements in A.

C[negs] = -C[negs]

Example— Using Vector and Array Operations

Whenever possible, vector and array data should always be processed with IDL array 
operations instead of scalar operations in a loop. For example, consider the problem 
of flipping a 512 × 512 image. This problem arises because approximately half the 
available image display devices consider the origin to be the lower-left corner of the 
screen, while the other half recognize it as the upper-left corner.

The following example is for demonstration only. The IDL system variable !ORDER 
should be used to control the origin of image devices. The ORDER keyword to the 
TV procedure serves the same purpose.

A programmer without experience in using IDL might be tempted to write the 
following nested loop structure to solve this problem:

FOR I = 0, 511 DO FOR J = 0, 255 DO BEGIN

• Temporarily save pixel:

TEMP=IMAGE[I, J]

• Exchange pixel in same column from corresponding row at bottom.

image[I, J] = image[I, 511 - J]
image[I, 511-J] = temp
ENDFOR

A more efficient approach to this problem capitalizes on IDL’s ability to process 
arrays as a single entity.

• Enter at the IDL Command Line:

FOR J = 0, 255 DO BEGIN

• Temporarily save current row.

temp = image[*, J]

• Exchange row with corresponding row at bottom.

image[*, J] = image[*, 511-J]
image[*, 511-J] = temp
ENDFOR
Getting Started with IDL Avoiding IF Statements for Performance
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At the cost of using twice as much memory, processing can be simplified even further 
by using the following statements:

• Get a second array to hold inverted copy.

image2 = BYTARR(512, 512)

• Copy the rows from the bottom up.

FOR J = 0, 511 DO image2[*, J] = image[*, 511-J]

• Even more efficient is the single line:

image2 = image[*, 511 - INDGEN(512)]

that reverses the array using subscript ranges and array-valued subscripts.

• Finally, using the built-in ROTATE function is quickest of all:

image = ROTATE(image, 7)

This works because inverting the image is equivalent to transposing it and 
rotating it 270 degrees clockwise.

Note
Another way to invert the image is to enter:
image = REVERSE(image, 2)
Avoiding IF Statements for Performance Getting Started with IDL
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More About Manipulating Data

IDL has many more array processing capabilities than the ones shown in this chapter. 
To take advantage of all of IDL’s powerful capabilities in manipulating data, look for 
more information in Building IDL Applications. Also see the following topics: 

• Chapter 6, “Importing and Writing Data into Variables” in the Using IDL 
manual

• Chapter 7, “Getting Information About Files and Data” in the Using IDL 
manual
Getting Started with IDL More About Manipulating Data
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Chapter 14

Creating Interfaces with 
the IDL GUIBuilder
This chapter describes the following topics:
What is the IDL GUIBuilder? . . . . . . . . . .  184
IDL GUIBuilder Tools . . . . . . . . . . . . . . . .  186
Creating an Example Application . . . . . . .  187

Widget Types  . . . . . . . . . . . . . . . . . . . . . .  197
More About the IDL GUIBuilder . . . . . . .  199
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What is the IDL GUIBuilder?

The IDL GUIBuilder is part of the IDL Development Environment. GUI stands for 
Graphical User Interface; the IDL GUIBuilder supplies you with a way to 
interactively create user interfaces. You can then generate the IDL source code that 
defines that interface and contains the event-handling routine place holders that 
complete your interface.

Note
The IDL GUIBuilder is supported on Windows only. However, the code it 
generates is portable to other platforms and will run on the same version of IDL or 
higher.

The IDL GUIBuilder has several tools that simplify application development. These 
tools allow you to create the widgets that constitute user interfaces, define the 
behavior of those widgets, define menus, as well as create and edit color bitmaps for 
use in buttons.

Note
When using code generated by the IDL GUIBuilder on other non-Windows 
platforms, more consistent results are obtained by using a row or column layout for 
your bases instead of a bulletin board layout. By using a row or column layout, 
problems caused by differences in the default spacing and decorations (for example, 
beveling) of widgets on each platform can be avoided.

Using the IDL GUIBuilder

These are the basic steps you will follow when building an application interface using 
the IDL GUIBuilder:

1. Interactively design and create a user interface using the components, or 
widgets, supplied in the IDL GUIBuilder. Widgets are simple graphical objects 
supported by IDL, such as sliders or buttons. 

2. Set attribute properties for each widget. The attributes control the display, 
initial state, and behavior of the widget.

3. Set event properties for each widget. Each widget has a set of events to which 
it can respond. When you design and create an application, it is up to you to 
decide if and how a widget will respond to the events it can generate. The first 
step to having a widget respond to an event is to supply an event procedure 
name for that event.
What is the IDL GUIBuilder? Getting Started with IDL
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4. Save the interface design to an IDL resource file, *.prc file, and generate the 
portable IDL source code files. There are two types of generated IDL source 
code: widget definition code (*.pro files) and event-handling code 
(*_eventcb.pro files).

5. Modify the generated *_eventcb.pro event-handling code file using the 
IDLDE, then compile and run the *.pro code. This code can run on any IDL-
supported platform.

The *_eventcb.pro file contains place holders for all of the event procedures you 
defined for the widgets, and you complete the file by filling in the necessary event 
callback routines for each procedure. 

Warning
Once you have generated the widget definition code (*.pro files), you should not 
modify this file manually. If you decide to change your interface definition, you 
will need to regenerate the interface code, and will therefore overwrite that *.pro 
file. The event handling code will not be overwritten but will instead be appended.

You can also create user interfaces programmatically in IDL without the GUIBuilder. 
Chapter 28, “Creating Widget Applications” in the Building IDL Applications 
manual contains complete information about IDL widgets, and it describes this 
process.
Getting Started with IDL What is the IDL GUIBuilder?
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IDL GUIBuilder Tools

You will use the following tools to design and construct a graphical interface using 
the IDL GUIBuilder:

• The IDL GUIBuilder Toolbar, which you use to create the widgets that make 
up your interface.

• Widget Properties dialog, which you use to set widget attributes and event 
properties.

• Widget Browser, which you can use to see the widget hierarchy and to modify 
certain aspects of the widgets in your application.

• The Menu Editor, which you use to define menus to top-level bases and 
buttons.

• The Bitmap Editor, which you use to create or modify bitmap images to be 
displayed on button widgets.

• The IDLDE to modify, compile, and run the generated code.

Using the IDL GUIBuilder Toolbar

The IDL GUIBuilder has its own toolbar in the IDE, which you use to create the 
widgets for your user interface. The components of the toolbar are shown in the 
following figure.

Figure 14-1: IDL GUIBuilder Toolbar
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Creating an Example Application

This simple example application contains a menu and a draw widget. When 
complete, the running application allows the user to open and display a graphics file 
in PNG format, change the color table for the image display, and perform a smooth 
operation on the displayed image.

The following example shows in various steps how to create a widget, set widget 
properties, and write IDL code to handle events:

Defining Menus for the Top-Level Base

To define the menu, follow these steps:

1. Open a new IDL GUIBuilder window by selecting File → New → GUI from 
the IDLDE menu, or click the “New GUI” button on the IDLDE toolbar.

2. Drag out the window so that the top-level base to a reasonable size for 
displaying an image. 

To view the property values, right-click on the base, and choose Properties 
from menu. In the Properties dialog, scroll down to view the X Size and Y 
Size property values.

3. Right-click on the top-level base in the IDL GUIBuilder window, then choose 
Edit Menu. This action opens the Menu Editor.

4. In the Editor’s Menu Caption field, enter “File” and click Insert. Clicking 
Insert sets the entered value and adds a new line after the currently selected 
line, and the new line becomes the selected line.

5. To define the File menu items:

• With the new line selected, click on the right arrow in the Menu Editor, 
which indents the line and makes it a menu item.

• Click in the Menu Caption field and enter “Open”.

• Click in the Event Procedure field and enter “OpenFile”. The OpenFile 
routine will be called when the user selects this menu.

• To create a separator after the Open menu, click the line button at the right 
side of the dialog (above the arrow buttons).

• To set the values and move to a new line, click Insert. 

• In the Menu Caption field, enter “Exit”.
Getting Started with IDL Creating an Example Application
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• In the Event Procedure field, enter “OnExit”.

• To set the values and move to a new line, click Insert. 

6. To define the Tools menu and its one item, do the following:

• With the new line selected, click the left arrow to make the line a top-level 
menu.

• In the Menu Caption field, enter “Tools”, then click Insert.

• Click the right arrow to make the new line a menu item.

• In the Menu Caption field, enter “Load Color Table”.

• In the Event Procedure field, enter “OnColor”.

• To set the values and move to a new line, click Insert. 

7. To define the Analyze menu and its one menu item, do the following:

• With the new line selected, click the left arrow to make the line a top-level 
menu.

• In the Menu Caption field, type “Analyze”, then press Enter.

• Click the right arrow to make the new line a menu item.

• In the Menu Caption field, enter “Smooth”.

• In the Event Procedure field, enter “DoSmooth”.

Figure 14-2: Menu Editor Dialog with Example Menus
Creating an Example Application Getting Started with IDL
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8. Save your menu definitions by clicking OK in the Menu Editor.

9. At this time you can click on the menus to test them.

10. From the IDLDE File menu, choose Save, which opens the “Save As” dialog.

11. In the “Save As” dialog, select a location, enter “example.prc” in the File name 
field, and click Save. This action writes the portable resource code to the 
specified file.

To create a draw area that will display PNG image files, follow these steps:

1. Click on the Draw Widget tool button (the dark square icon), then drag out an 
area that fills the top-level base display area. Leave a small margin around the 
edge of the draw area when you drag it out.

2. Right click on the draw area, and choose Properties. This action opens the 
Properties dialog for the draw area; the draw widget properties are displayed 
in the dialog.

3. In the Properties dialog, click the push pin button (in the top right corner of 
the dialog box) so the dialog will stay open and on top.

Note
This Properties dialog floats and is resizeable.
Getting Started with IDL Creating an Example Application
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4. In the Properties dialog, change the draw widget Name attribute value to 
“Draw”. 

Later, you will write code to handle the display of the image in this draw area widget. 
Renaming the widget now will make it easier to write the code later; the “Draw” 
name is easy to remember. 

Note
The Name property must be unique to the widget hierarchy.

5. In the IDL GUIBuilder window, click on the top-level base widget to select it. 
When you do so, the Properties dialog will update and display the attributes 
for this base widget.

Figure 14-3: Changing the Name Attribute to “Draw”
Creating an Example Application Getting Started with IDL
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6. In the Properties dialog, locate the Component Sizing property, and select 
Default from the droplist values. This action sizes the base to the draw widget 
size you created. 

When the size of the base was first dragged out, the Component Sizing 
property changed from Default to Explicit—you explicitly sized the widget. 
Now that the base widget contains items, you can return it to Default sizing, 
and IDL will handle the sizing of this top-level base.

7. From the File menu, choose Save.

Running the Application in Test Mode

You can run the application in test mode, which allows you to test the display of 
widgets and menus.

To run your application in test mode:

• From the Run menu, choose Test GUI.

This action displays the interface as it will look when it runs.

To exit test mode:

• Press the Esc key or Click the close X in the upper-right corner of the test 
application window.

Generating the IDL Code

To generate the code for the example application, follow these steps:

1. From the File menu, choose Generate .pro. This action opens the “Save As” 
dialog. 

2. In the “Save As” dialog, find the location where you want the files saved, enter 
“example.pro” in the File name field, and click Save.

This action generates an example.pro widget definition file and an 
example_eventcb.pro event-handling file. 

The example.pro file contains the widget definition code, and you should never 
modify this file. If you decide later to change your interface, you will need to 
regenerate this interface code, and thus overwrite the widget code file.

The example_eventcb.pro contains place holders for all the event procedures you 
defined in the IDL GUIBuilder Menu Editor and Properties dialog. You must 
complete these event procedures by filling in event callback routines. This file will 
Getting Started with IDL Creating an Example Application
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only be appended to when new event handlers are added so changes made will not be 
lost.

Note
You should modify only the generated event-handling file (*_eventcb.pro); you 
should never modify the generated interface code (the *.pro file). 

Handling the Open File Event

You can now modify the generated example_eventcb.pro file to handle the 
events for the application. First, you will modify the OpenFile routine.

When the user selects Open from the File menu of the example application, the 
appropriate event structure is sent, and the OpenFile routine handles the event. For 
this application, the Open menu item will launch an Open dialog to allow the user to 
choose a PNG file, and then the routine will check the selected file’s type, read the 
image, and display it in the draw area.

To open the file and add the code to handle the OpenFile event, follow these steps:

1. From the File menu in the IDLDE, choose Open, which launches the Open 
dialog.

2. In the Open dialog, locate and select the example_eventcb.pro file, and 
click Open. This file contains the event handling routine place holders, which 
you will now complete.

3. In the example_eventcb.pro file, locate the OpenFile procedure, which 
looks like this:

PRO OpenFile, Event

END

Tip
To find the OpenFile routine, select OpenFile from the Functions/Procedures drop-
down list on the IDLDE toolbar.

4. Add the following code between the PRO and END statements to handle the 
event:

; If there is a file, draw it to the draw widget.
sFile = DIALOG_PICKFILE(FILTER='*.png')
IF(sFile NE "")THEN BEGIN

; Find the draw widget, which is named Draw.
wDraw = WIDGET_INFO(Event.top, FIND_BY_UNAME='Draw');
Creating an Example Application Getting Started with IDL
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; Make sure something was found.
IF(wDraw GT 0)THEN BEGIN

; Make the draw widget the current, active window.
WIDGET_CONTROL, wDraw, GET_VALUE=idDraw
WSET,idDraw
; Read in the image.
im = READ_PNG(sFile, r, g, b)
; If TrueColor image, quantize image to pseudo-color:
IF (SIZE(im, /N_DIM) EQ 3) THEN $

im = COLOR_QUAN(im, 1, r, g, b)
; Size the image to fill the draw area.
im = CONGRID(im, !D.X_SIZE, !D.Y_SIZE)
; Handle TrueColor displays:
DEVICE, DECOMPOSED=0
; Load color table, if one exists:
IF (N_ELEMENTS(r) GT 0) THEN TVLCT, r, g, b
; Display the image.
TV, im
; Save the image in the uvalue of the top-level base.
WIDGET_CONTROL, Event.top, SET_UVALUE=im, /NO_COPY

ENDIF
ENDIF

Note
In the added code, you used the FIND_BY_UNAME keyword to find the draw 
widget using its name property. In this example, the widget name, “Draw”, is the 
one you gave the widget in the IDL GUIBuilder Properties dialog. The widget name 
is case-sensitive.

Now re-save example.pro to be sure that the changes are retained.

Handling the Exit Event

To add the code that causes the example application to close when the user chooses 
Exit from the File menu, follow these steps:

1. Locate the OnExit procedure place holder, which looks like this:

PRO OnExit, Event

END

2. Add the following statement between the PRO and END statements to handle 
the destruction of the application:

WIDGET_CONTROL, Event.top, /DESTROY
Getting Started with IDL Creating an Example Application
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Handling the Load Color Table Event

To add the code that causes the example application to open the IDL color table 
dialog when the user chooses Load Color Table from the Tools menu, follow these 
steps:

1. Locate the OnColor routine place holder, which looks like this:

PRO OnColor, Event

END

2. Add the following code between the PRO and END statements:

XLOADCT, /BLOCK
; Find the draw widget, which is named Draw:
wDraw = WIDGET_INFO(Event.top, FIND_BY_UNAME='Draw')
IF(wDraw GT 0) THEN BEGIN

; Make the draw widget the current, active window:
WIDGET_CONTROL, wDraw, GET_VALUE=idDraw
WSET, idDraw
WIDGET_CONTROL,Event.top, GET_UVALUE=im, /NO_COPY
; Make sure the image exists:
IF (N_ELEMENTS(im) NE 0) THEN BEGIN
; Display the image:

TV, im
; Save the image in the uvalue of the top-level base:
WIDGET_CONTROL, Event.top, SET_UVALUE=im, /NO_COPY

ENDIF
ENDIF

This procedure opens a dialog from which the user can select from a set of predefined 
color tables. When the user clicks the name of a color table, it is loaded and the 
displayed image changes appropriately.

Note
The XLOADCT color table dialog affects only 8-bit display devices.

Handling the Smooth Event

When the user selects Smooth from the Analyze menu, a smooth operation is 
performed on the displayed image. The smooth operation displays a smoothed image 
with a boxcar average of the specified width, which in the example code is 5.

To add the callback routines to handle the smooth operation, follow these steps:

1. Locate the DoSmooth routine place holder, which looks like this:
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PRO DoSmooth, Event

END

2. Add the following code between the PRO and END statements to handle the 
smooth operation:

; Get the image stored in the uvalue of the top-level-base.
WIDGET_CONTROL, Event.top, GET_UVALUE=image, /NO_COPY
; Make sure the image exists.
IF(N_ELEMENTS(image) GT 0)THEN BEGIN

; Smooth the image.
image = SMOOTH(image, 5)
; Display the smoothed image.
TV, image
; Place the new image in the uvalue of the button widget.
WIDGET_CONTROL, Event.top, SET_UVALUE=image, /NO_COPY

ENDIF

3. From the File menu, choose Save, which saves all your changes to the 
example_eventcb.pro file.

Compiling and Running the Example Application

To compile and run your example application, follow these steps:

1. Type example at the IDL> command prompt. This compiles and runs the 
example application, opening the GUI interface that has been created.

2. Now open a PNG image to try out the new application. From the File menu 
choose Open, locate a PNG file, and click “Open”.

3. You will now see the image opened in your GUI window. To manipulate the 
color schemes, click Tools/Load Color Table. The following figure shows the 
example application and the IDL color table dialog. You can also perform the 
smooth procedure on the image.
Getting Started with IDL Creating an Example Application
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Figure 14-4: The Example GUI Application
Creating an Example Application Getting Started with IDL
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Widget Types

The IDL GUIBuilder toolbar allows you many options for creating widgets of 
various types. The following table contains a short listing and descriptions of the 
widget types you can create using the toolbar:

Widget Description

Base Creates a container for a group of widgets within a top-level 
base container (which is contained in the IDL GUIBuilder 
window).

Button Creates a push button. The easiest way to allow a user to interact 
with your application is through a button click. 

Radio Button Creates a toggle button that is always grouped within a base 
container.

Checkbox Creates a checkbox, which you can use either as a single toggle 
button to indicate a particular state is on or off or as a list of 
choices from which the user can select none to all choices.

Text Creates a text widget.

Label Creates a label.

Horizontal and 
Vertical Sliders

Creates a slider with a horizontal or vertical layout.

Droplist Creates a droplist widget, which you can use to present a 
scrollable list of items from which the user can select.

Listbox Creates a list widget, which you can use to present a scrollable 
list of items from which the user can select.

Draw Area Creates a draw area, which you can use to display graphics in 
your application.

Table Creates a table widget, which you can use to display data in a 
row and column format.

Tab Creates a tab widget on which different “pages” (base widgets 
and their children) can be displayed by first selecting the 
appropriate tab.

Table 14-1: Widget Types and Descriptions
Getting Started with IDL Widget Types
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Note
The Select Cursor button returns the cursor to its standard state, and it indicates that 
the cursor is in that state. After you click on another button and create the selected 
widget, the cursor returns to the selection state.

Widget Properties

For each widget type, there is a set of attribute values and a set of event values you 
can set using the IDL GUIBuilder Properties dialog. When you select a widget in the 
IDL GUIBuilder window or in the Widget Browser, the Properties dialog is updated 
to contain the properties for the selected widget. These properties include those 
common to all widgets and those specific to the selected widget. 

On the Attributes tab of the Properties dialog (right click on the draw area, and 
choose Properties. This action opens the Properties dialog for the draw area) the 
attributes are set to default values and are arranged in the following order:

• Name property

• Combined Alphabetical list of common and widget-specific properties

On the Events tab, the possible events for a widget are listed in alphabetical order, 
with the common and the widget-specific events combined. By default, no event 
values are set initially. When you enter a routine name for an event property, you are 
responsible for making sure that event procedure exists. IDL does not validate the 
existence of the specified routine.

Tree Creates a tree widget, which presents a hierarchical view that 
can be used to organize a wide variety of data structures and 
information.

Widget Description

Table 14-1: Widget Types and Descriptions
Widget Types Getting Started with IDL
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More About the IDL GUIBuilder

The functionality shown here is only a small part of the capabilities of the IDL 
GUIBuilder. You can find much more information on building your own user 
interfaces in Chapter 29, “Using the IDL GUIBuilder” in the Building IDL 
Applications manual.
Getting Started with IDL More About the IDL GUIBuilder
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Chapter 15

Where to Go 
From Here
Using just a few examples, you’ve now gained a brief glimpse at the many and 
powerful options that IDL offers you for data analysis, visualization, and cross-
platform application development. But the power of IDL has only begun and IDL 
offers you many options to aid you in learning more and more about its incredible 
functionality.
Getting Started with IDL 201
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Learning More about IDL

A multitude of resources are made available to you to assist you as you learn the 
many capabilities of IDL. IDL manuals are offered both printed and online (in PDF 
version). IDL also includes an online help system directly accessible from the IDL 
Development Environment.

IDL Documentation Set

If you have just purchased IDL, you will receive part of the documentation set 
(depending upon which products you have purchased) in printed form with your 
order. All IDL manuals are available in PDF form on your product CD-ROM. For 
more information, see “Online Manuals” on page 205.

Installing and Licensing IDL 6.2

Installing and Licensing IDL 6.2 describes how to install and license IDL on your 
platform. It provides information about the different types of licensing available for 
IDL and how to manage licensing on your system.

Using IDL

Using IDL explains IDL from an interactive user’s point of view. It contains 
information about the IDL environment, the structure of IDL, and how to use IDL to 
analyze and visualize your data.

Building IDL Applications

Building IDL Applications explains how to use the IDL language to write programs - 
from simple procedures to large, complex applications. It contains information on the 
structure of the IDL language, programming techniques, and tools you can use to 
create applications in IDL.

Image Processing in IDL 

Image Processing in IDL introduces you to the full image processing power of IDL, 
describing how to display, manipulate, and extract information from images. This 
manual features both Direct Graphics and Object Graphics examples that will aid in 
developing IDL applications that require image processing. 
Learning More about IDL Getting Started with IDL
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iTool User’s Guide

The iTool User’s Guide shows you important iTool functionality such as how to start 
the iTools, how to import data into an iTool, how to export data out of an iTool, the 
general layout of the iTools, and how to perform common iTool tasks.

iTool Developer’s Guide

The iTool Developer’s Guide describes the IDL iTools component framework and 
provides examples of its use. The manual helps you understand how to use the 
component framework to create your own intelligent tools.

IDL Quick Reference

The IDL Quick Reference provides quick access to the following: IDL procedures 
and functions (categorized functionally and alphabetically), objects, executive 
commands, and statements.

IDL Reference Guide

The IDL Reference Guide contains detailed information about all of IDL’s 
procedures, functions, objects, system variables, and other useful reference materials. 
It also contains detailed information about IDL’s routines for dealing with Common 
Data Format (CDF), Hierarchical Data Format (HDF), Earth Observing System 
extensions to HDF (HDF-EOS), and Network Common Data Format (NetCDF) files.

Object Programming

Object Programming discusses object-oriented programming using IDL and contains 
information about IDL’s object graphics system.

External Development Guide

The External Development Guide explains how to use IDL to develop applications 
that interact with programs written in other programming languages.

Obsolete IDL Features

Obsolete IDL Features describes routines that have become obsolete by 
enhancements to the IDL language. While these routines continue to exist, RSI 
recommends that you do not use routines that have become obsolete in new code. 
Getting Started with IDL Learning More about IDL
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IDL DataMiner Guide

The IDL DataMiner Guide contains information on using IDL to interact with 
databases using the Open Database Connectivity (ODBC) interface.

Note
Additional documentation can be ordered from RSI by contacting RSI Sales at 
(303) 786-9900 or by visiting www.RSInc.com.

Online Help

IDL is equipped with extensive on-line help facilities that provide two kinds of 
information: documentation for the IDL language and information on the status of the 
IDL environment. There are several ways to access these help facilities from within 
the IDL: 

The IDL Development Environment Help Menu

To view the IDL help system, select “Contents” from the “Help” pull-down menu in 
the IDL Development Environment. You can also search using the “Find Topic” 
selection on the same menu.

The Question Mark

You can access the IDL Help by entering a question mark (?) at the IDL prompt. The 
IDL Online Help window appears. The most current documentation on any aspect of 
IDL is available through this command. Although the help window has buttons for 
performing searches, you can also perform a keyword search from the command line 
by entering “?” followed by a keyword for which you want to search. For example, to 
search for topics related to contouring when starting the help system, you could enter:

? CONTOUR

IDL Help Outside of the IDL Development Environment

You can access the IDL online help system when IDL itself is not running. On UNIX 
and Mac OS X, execute the following at the shell prompt:

idlhelp

On Windows platforms, select IDL Online Help from the Start menu.

HELP Command

The HELP procedure gives information about the IDL session. Enter:
Learning More about IDL Getting Started with IDL
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HELP

with no additional parameters to display an overview of the current IDL session 
including one-line descriptions of all variables and the names of all compiled 
procedures and functions. Enter:

HELP, variable

to display information about that variable’s type. Many keyword parameters can be 
used with the HELP procedure to retrieve more specific information.

Online Manuals

All volumes of the IDL documentation set are also available in Adobe Acrobat 
Portable Document Format (PDF). These PDF files are provided on the IDL 
installation CD-ROM, but are not automatically installed on your machine along with 
IDL. In order to view these manuals, you will need a copy of Adobe’s Acrobat 
Reader software. For more information on Adobe Acrobat Reader, visit their World 
Wide Web site at www.adobe.com.

How to Access IDL Online Manuals

The IDL online manuals are located in the info/docs directory of your IDL 
CD-ROM.

Navigation of the IDL Online Manuals

The online IDL manuals are fully hypertext linked for easy navigation. You can also 
use the bookmarks panel at the left of the Acrobat Reader window to switch between 
manuals.

Searching within the Online Manual Set

The IDL online manuals are set up to search for any information you might need 
within the IDL manual set. To search the IDL manual set, you can click on the 
binocular/page button in the Acrobat Reader tool bar after you have opened any IDL 
manual in the set.
Getting Started with IDL Learning More about IDL
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IDL Demo Applications and Examples

The IDL Demo Applications illustrate some of the many ways IDL can help visualize 
data. The IDL Demo Applications are a series of programs written in the IDL 
language that demonstrate different aspects of IDL. To Start the Demo Applications, 
complete the following steps:

For Windows, by clicking the Windows Start button and selecting Start → 
Programs → Research Systems IDL 6.2 → IDL Demo.

For UNIX and Mac OS X, enter the following at the UNIX prompt:

idldemo

Note
If you have already started IDL, you can simply type in DEMO at the IDL prompt.

IDL> DEMO

Another way to access the IDL Demo System is to use the “Run Demo” toolbar 
button on the IDLDE toolbar. To use this feature simply click the button and the 
dialog for running the demo will appear.

IDL also comes with many built-in examples such as source code and example data 
files. These can be found in the RSI-DIR/examples where RSI-DIR is the 
directory in which you have installed IDL.
IDL Demo Applications and Examples Getting Started with IDL
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Contacting RSI

Address

Research Systems, Inc.
4990 Pearl East Circle
Boulder, CO 80301

Phone

(303) 786-9900
(303) 413-3920 (Technical support)

Fax

(303) 786-9909

E-mail

Sales inquiries: info@RSInc.com 
Technical support: support@RSInc.com 
Training information: training@RSInc.com 

World Wide Web

Visit RSI’s web site at www.RSInc.com.
Getting Started with IDL Contacting RSI
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Index

Numerics
2D

plot, 53

A
Adobe

Portable Document Format (PDF), 205
animation

wire mesh surface, 157
annotating

maps, 132
axes

turning off, 160
azimuthal equidistant map projection, 131

C
clipboard support

graphics windows, 22
code

modifying generated (GUIBuilder), 192
color tables

example (GUIBuilder), 194
loading, 95

colors
contrast enhancement, 73
filling contours, 102
scaling, 68

Command Line
IDLDE, 22

Contents button, 204
contours

filling, 102
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iContour tool, 92
levels, 101
3D perspective, 103
tickmarks, 102

contrast enhancement, 73
creating

data, 53

D
data

irregularly gridded, 144
data sets

creating, 53
plotting, 46

datasets
creating, 53, 145

differentiated smoothing, 80
direct graphics

clipboard support, 22
dismissing windows, 68
displaying

2D plots in iPlot, 39
draw widgets

GUIBuilder example, 189
drawing

latitude and longitude lines, 130

E
Editor windows

defined, 21
elevation levels. contours, 101
events

handling in IDL GUIBuilder code, 192

F
Fast Fourier transform

noise reduction filter, 57

filling
contours

example, 102
filtering

Fourier transform, 57
frequency domain filtering, 57

G
globe, drawing, 129
graphics

clipboard support, 22
windows

dismissing, 68
OS clipboard support, 22
resizing, 72

gridding
latitude and longitude lines, 130
quintic, 149

H
help on IDL, 204

I
iContour tool, 92
IDL

getting help, 204
IDL Code Profiler, 171
IDL Development Environment. See IDLDE
IDL GUIBuilder

access, 21
base widgets

use, 197
button widgets

use, 197
checkbox widgets

use, 197
draw widgets
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use, 197
droplist widgets

use, 197
examples

color table example, 194
compiling and running, 195
creating draw area, 189
defining menus, 187
modifying code, 192

files
modifying generated, 192

label widgets
use, 197

listbox widgets
use, 197

radio button widgets
use, 197

slider widgets
use, 197

smooth example, 194
starting, 187
tab widgets

use, 197
table widgets

use, 197
test mode, 191
text widgets

use, 197
toolbar, 186
tools, 186
tree widgets

use, 198
writing event-handling code, 192

IDLDE
layout, 19

iImage tool
about, 65

image display
getting started, 67
routines, 64

images

contrast enhancement, 73
iImage tool, 65
opening, 67
reading, 67, 67
rotating, 83
sharpening, 79
smoothing, 79

input/output
getting started, 30

interpolation
linear, 149
quintic, 149

iPlot
tool, 39

irregularly gridded data, 144
iSurface tool

using, 90
iVolume tool

using, 109

L
latitude lines, 130
levels, contour, 101
lines

drawing latitude and longitude, 130
horizon, 130

longitude lines, 130

M
mapping

annotations, 132
getting started, 124
grid of latitude and longitude lines, 130
horizon line, 130
limiting region mapped, 131
projection

azimuthal equidistant, 131
orthographic, 129
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multiple plot displays, 60

O
object graphics

clipboard support, 22
objects

object graphics
clipboard support, 22

opening
image files, 67

orthographic map projection, 129
Output Log

overview, 23
overplotting, 102

in iPlot, 40

P
PDF files, 205
performance

analyzing, 171
pixels

brightness profile, 85
scaling, 76

plots
displaying 2-D with iPlot, 39
overplotting in iPlot, 40

plotting
annotating maps, 132
displaying multiple plots, 60
iPlot tool, 39
irregularly gridded data, 144
other capabilities, 48
overplotting, 102
simple, 43
surfaces, 164
symbols, 146
text size, 96
titles, 96

plotting with data sets, 46
printing

plot (direct graphics), 44
profiling, 171
project

interface, 20
projections, map

azimuthal equidistant, 131
orthographic, 129

projects
overview, 172

Q
quintic interpolation, 149
quitting IDL, 27

R
reading

images, 67
reading binary data, 33
reading images, 34
real-world test data, 54
rendering volumes, 109
resizing

graphics windows, 72
rotating

images, 83
routines

image display, 64

S
scaling

pixels, 76
sharpening an image, 79
signal processing

and IDL, 52
SIN function, 53
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sinewave function, 53
slices

making, 117
smoothing

example, 194
images, 79

Status Bar, IDLDE, 23
surfaces

displaying, 119
iSurface tool, 90
plotting, 164
wire mesh animation, 157

T
test data, 54
test mode, IDL GUIBuilder, 191
text

size, 96
three-dimensional

contour plot, 103
thresholding, 73
toolbars

IDL GUIBuilder, 186
IDLDE, 20, 20, 21, 22

tutorials, 15

U
unsharp masking, 79

V
Variable Watch Window, 170
variables

displaying current, 170
volumes

extents, 110
iVolume tool, 109
rendering, 109

W
widgets

creating in IDL GUIBuilder, 186
windows

clipboard support for graphics, 22
deleting, 161
dismissing, 68
resizing, 72

wire mesh surface
animation, 157

writing images, 34
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